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Getting help and support

Technical support

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the Web site,
www.tektronix.com.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

General Information All instrument model numbers

®» Hardware options, if any
= Probes used
®  Your name, company, mailing address, phone number, FAX number

m  Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

Software version number

Application Specific
Information

Description of the problem such that technical support can duplicate the
problem

m Ifpossible, save the setup files for all the instruments used and the
application.

m  Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file.

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file.

TekExpress HDM Advanced Analysis and Compliance Solution
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Overview and key specifications

Supported tests- HDM Source

TekExpress HDM Source supports the following automated single-ended and
differential tests:

Differential tests

HF1-2: Source TMDS Electrical — 6G — TRISE, TFALL

This test confirms that the rise times and fall times on the TMDS differential
signals fall within the limits of the specification.

HF1-3: Source TMDS Electrical — 6G — Inter-Pair Skew

This test confirms that the skew between two data lanes on the TMDS
differential signals fall within the limits of the specification.

HF1-5: Source TMDS Electrical — 6G — Differential Voltage

This test confirms that the voltage level of the TMDS differential signals
complies with the limits mentioned in specification.

HF1-6: Source TMDS Electrical — 6G — Clock Duty Cycle

This test confirms that the duty cycle and clock rate of the TMDS differential
clock complies with the limits mentioned in specification.

HF1-7: Source TMDS Electrical — 6G — Clock Jitter

This test confirms that the clock jitter of the TMDS differential clock
complies with the limits mentioned in specification.

Single ended tests

TekExpress HDM Advanced Analysis and Compliance Solution

HF1-8: Source TMDS Electrical — 6G — Data Eye Diagram

This test confirms that the HDMI Data output has signal quality that meets
the eye opening required by the specification

HF1-1: Source TMDS Electrical — 6G — VL

This test confirms that the low voltage level of the TMDS single ended
signals complies with the limits mentioned in specification.

HF1-4: Source TMDS Electrical — 6G — Intra-Pair Skew

This test confirms that the skew between the positive and negative lane of the
TMDS single ended signals complies with the limits mentioned in
specification.



Overview and key specifications

Supported tests- HDM Sink

TekExpress HDM Sink supports the following automated HDM Sink Electrical
and Sink Protocol tests.

These tests are supported for CTS Version 2.0:
HDM Sink Electrical tests

HF 2-1-Min/Max Differential Swing Tolerance
HF 2-2-Intra-Pair Skew
HF 2-3-Jitter Tolerance

HDM Sink Protocol tests

HF2-6 Sink Video Timing - 6G - 2160p 24 bit Color Depth
HF2-7 Sink Video Timing - 6G - 2160p Deep Color

HF2-8 Sink Video Timing - 6G - 2160p 3D

HF2-23 Sink Pixel Decoding YCBCR 4:2:0

HF2-24 Sink Pixel Decoding YCBCR 4:2:0 Deep Color

HF2-25 Sink Video Timing - 21:9 (64:27)

HF2-36 Sink Video Timing - 6G - Non-2160p 24 bit Color Depth
HF2-37 Sink Video Timing - 6G - Non-2160p Deep Color
HF2-38 Sink Video Timing - 6G - Non-2160p 3D

Supported resolutions- HDM Source

CTS 2.0: All of the TekExpress HDM tests can be performed for DUTs
operating in resolutions between 3.4 GHz to 6 GHz. Other resolutions that fall
within this range can be entered in the Low Resolution and High Resolution
fields on the DUT tab of the Setup panel.

When Low and High resolutions are the same, the software performs the test at
that one resolution.

Table 1: Supported resolutions (Source)

DUT Configuration
Measurement name Highest supported TMDS Character rate Lowest
supporte
d TMDS
Characte
r rate
1-8: TMDS - Data Eye diagram Yes N/A
1-7: TMDS Clock Jitter Yes N/A
Vswing Yes N/A
4 TekExpress HDM Advanced Analysis and Compliance Solution



Overview and key specifications

DUT Configuration

Measurement name Highest supported TMDS Character rate Lowest
supporte
d TMDS
Characte
r rate

1-2: TMDS Rise time Yes N/A

1-2: TMDS Fall time Yes N/A

1-6 TMDS Clock Duty cycle

Duty Cycle (Maximum) Yes Yes

Duty Cycle (Minimum) Yes Yes

Clock rate = 1/Mean Period Yes Yes

1-3: TMDS - Inter-Pair Skew Yes N/A

1-5: Differential Voltage N/A Yes

Eye N/A Yes

Maximum Differential Voltage Vhigh N/A Yes

Maximum Differential Voltage Viow N/A Yes

Single ended tests

1-4; TMDS - Intra-Pair Skew Yes N/A

1-4: TMDS - VL N/A Yes

Supported resolutions- HDM Sink

CTS 2.0: All of the TekExpress HDM Sink tests can be performed at data rates
297G, 3.71 G, 4.46 G and 5.94 G.

TekExpress HDM Advanced Analysis and Compliance Solution 5
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Operating basics

Equipment connection setup (HDM Source)

You need the following equipment to run HDM Transmitter tests. (For details,
see Minimum system requirements):

A supported Tektronix oscilloscope

Four differential probes — P7313SMA, for single ended and differential tests
Device under test (DUT)

TF-HDM-TPA-S fixture

PWS4205, PWS2185 or 2220-30-1/ 2220J-30-1 Dual Power Supply (if using
external power supply option)

Any approved EDID analyzer

Connection diagrams and the tests they apply to are listed below.

Single Ended and
Differential Tests

Table 2: Source differential tests

Differential Voltage

Test number and characteristic tested Setup diagram

HF1-2: Source TMDS Electrical - 6G — TRISE, | Source differential diagram
TFALL

HF1-3: Source TMDS Electrical - 6G — Inter- | Source differential diagram
Pair Skew

HF1-5: Source TMDS Electrical — 6G - Source differential diagram

HF1-6: Source TMDS Electrical - 6G — Clock | Source differential diagram
Duty Cycle

HF1-7: Source TMDS Electrical - 6G — Clock | Source differential diagram
Jitter

TekExpress HDM Advanced Analysis and Compliance Solution




Operating basics

Source differential diagram
Differential measurement

Power supply

¥ \cwcm

S

CLOCK_P
EDID emglf?i f EDID PCB g DATA2_P @
- (1, DATA2 N (P
DATAI P ——
; {_Pull ué )
: e |
= | —i = - e
SouceDUT & | | ___DATAQ_N A
g  CLOCK.P
S -
-, CLOCK N
71 HPD
(11 HPD
Notes:
Connect to biased 50¢2 termination such as input port of unoccupied differential SMA probes. w2001
Table 3: Source single ended tests
Test number and characteristic tested Setup diagram
HF1-8: Source TMDS Electrical - 6G — Data Source data eye diagram
Eye Diagram
HF1-1: Source TMDS Electrical - 6G — VL and | Source single ended diagram
VSwing
HF1-4: Source TMDS Electrical - 6G — Intra- | Source single ended diagram
Pair Skew

8 TekExpress HDM Advanced Analysis and Compliance Solution



Operating basics

Source data eye diagram
Data eye diagram measurement

Power supply

03.30]

L

Power supply

<4 I\
i ] :’;%T%—SOQ termination
= J | E
L{l:"f r “3@ “ 7
ﬂ 'w‘\/ 7~ Data_PIN
o) |~ CLOCKN
=
CLOCK_P
EDID emulator / EDID PCB DATA2 P
T ) =—Pullup)
= DATAZ N Pull up
L= RATMP g up
_ DATA1 N
z s fjmm, {_ Pullup )
= __ DATAO_P A
5 4 Lk
SowceDUT [ | _ DATAON A
§ . CLOCK_P
h ., CLOCK N
1 HPD
11— HPD
Notes:
Connect to biased 50€2 termination such as input port of unoccupied differential SMA probes. w0
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Operating basics

Source single ended diagram
Single ended measurement

Power supply

Source DUT

J0138UU0Y) [NAH

CLOCK_N

1 HPD
= HPD

Notes:

Connect to biased 50€2 termination such as input port of unoccupied differential SMA probes. p—_—

10 TekExpress HDM Advanced Analysis and Compliance Solution



Operating basics

See Also  Equipment connection setup (HDM Sink)

About algorithms

Equipment connection setup (HDM Sink)

You need the following equipment (for details, see Minimum system
requirements):

A supported Tektronix oscilloscope
Device under test (DUT)

TCA-SMA connectors-Two numbers, One AFG3102/AFG3102C/AFG3252/
AFG3252C

Eight 12 GHz Bias T (mini circuit bias T model no zx85-12G-s+)
Two 120 psec Rise time filter (5115110-120)

One Power supply external (PWS4721/PWS4602/PWS4323/PWS4305/
PWS4205)

Two AWG70002A with option 01, 03 and 225, or twvo AWG7122C with
option 1, 2/6, 8

TF-HDM-TPA-S

10 SMA cables (174-1428-00)
Four BNC to SMA converter
BNC T connector

Three BNC cables

Connection diagrams and the tests they apply to are listed below.

NOTE. GPIB connection is supported only for AWG7122C. If using AWG7122C
and GPIB connections, three numbers of NI-GPIB cables will be needed.

Sink tests

Table 4: Sink Electrical tests

Test number and characteristic tested

Setup diagram

*HF 2-1: Min/Max Differential Swing Tolerance Sink Electrical min diagram for AWG70002A

Sink Electrical max diagram for AWG70002A
Sink min/max diagram for AWG7122C

*HF 2-2: Intra-Pair Skew

Sink Electrical intra-pair skew diagram for AWG70002A
Sink intra-pair skew diagram for AWG7122C

*HF 2-3: Jitter Tolerance

Sink Electrical jitter tolerance diagram for AWG70002A
Sink jitter tolerance diagram for AWG7122C

TekExpress HDM Advanced Analysis and Compliance Solution 11



Operating basics

12

Diagram for Sink
for AWG70002A

Electrical min, intra-pair skew, jitter tolerance and protocol tests

AWGT0002A 10 MHz Ref Out (Master)

AFG WEXI Ref In

2§ § @ @] AWGTOD02A (Slave)
l[ Ext Clock In | (O &

] °
wooso |TiginA TriginA B090
v @ o000 PG oooo
CLK DO | Marker D1 D2 Marker
output output
'y
120ps TTC Filter J
LI BEg
DPO/DSA/MSO 70000 Seri
Y |\ Y Bias SAMS Series - y ‘:‘
| voltage L 1\‘
D1 D2 e
Power supply
o / —
- Second row of
B % b connectors below
k CLK J;'_‘ }m
- i oman

Diagram for Sink

Electrical max test for AWG70002A

AFG WExt RefIn

5 T 8® © ©® © | AWGFO002A (Slave)
ol Ext Clock In 5 2 5
Trig In A Trig InA )

CLK

D1 Marker
output
: DPO/DSA/MSO 70000 Series ¥
Bias Bias
voltage voltage ‘
Y ot
Power sdpply
s -
\\ CLK

NOTE. For AWG7122C, the connection remains the same as the nominal pattern.
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Operating basics

Diagram for Sink Electrical jitter tolerance, intra-pair skew, and min/max tests for
AWGT7122C

AFG w Ext Ref In

AWGT7122C (XDMHzReIOul(Maﬂe(] AWGT122C (Slave)
| emm—

ek | | | Merker | |20 K = D1 | [Marker | | o,
output output
——\ N & = — {
Y b DPO/DSA/MSO 70000 Series e 1
rr o ias I
‘ —‘ W voltage voltage 1 [
L L] Yf o] | QL )
Power suppl -
wer supply ﬁ/ ‘ DUT
A Do | _—
o 1
e I~ Second row of
: % : connectors below
\_ CLK W% |
o o
Diagram for Sink Electrical min, intra-pair skew, jitter tolerance and protocol tests
for AWG70002A
AFG w Ext Ref In
AWG700024 |10 MHz Ref Out (Master) ] @ | AWGT0002A (Slave)
O . [ Ext Clock In S =
) soes |TighA TighhA _ ¢ T
o (5] G eaea Y ) 6000
CLK DO | Marker D1 D2 |Marker
output output
ry o
120ps TTC Filter | | &
Ll 1 L1
YYYY i DPO/DSAMSO 70000 Series . YV
1as 1
[ [ L voltage voltage L ‘L
jid D1 D2 SE—
Power supply
o
Second row of
_ connectors below
\
\. -
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Operating basics

Diagram for Sink Protocol test for AWG7122C

~ AWGT122C [U MHz Ref Out (Master)

Trig In A

AFG \Elegf In

AWGT122C (Save)

@ G , | &
WEE
J\ Ext Clock In |
|

Trig In A
290 il s i
Marker |CLK Do =5 1| Marker| D1 D2
output of ¢ ;‘ output
ot :
poe) @ B | 3|
M JC |
'l Bias DPO/DSA/MSQ 70000 Series Bias Y
! ‘ voltage voltage [ ‘
Y ot] || | o2
Power supply 2 * |
ﬁ//@ [| ||ouT
\ Do P
\ T~ ‘ Second row o
‘; _ connectors below
\_ CLK
\ e
Table 5: Sink Protocol tests
Test number and characteristic tested Setup diagram

HF2-6 Sink Video Timing - 6G - 2160p 24 bit Color Depth

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-7 Sink Video Timing - 6G - 2160p Deep Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-8 Sink Video Timing - 6G - 2160p 3D

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

*HF2-23: Sink Pixel Decoding YCBCR 4:2:0

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-24 Sink Pixel Decoding YCBCR 4:2:0 Deep Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-25 Sink Video Timing - 21:9 (64:27)

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-36 Sink Video Timing - 6G - Non-2160p 24 bit Color Depth

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-37 Sink Video Timing - 6G - Non-2160p Deep Color

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

HF2-38 Sink Video Timing - 6G - Non-2160p 3D

Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C
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Application directories and usage

Operating basics

The application directory and associated files are organized as follows:

Bin

Compliance Suites
Documents
Examples

ICP

Images

Lib

Report Generator

Tools

The following table lists the default directory names and their usage.

Table 6: Application directories and usage

Directory names

Usage

InstallDinTekExpress\TekExpress HDM

Contains the application and associated files

TekExpress HDM\Bin

Contains miscellaneous HDM application
libraries

TekExpress HDM\Compliance Suites

Contains compliance-specific files and filter files

TekExpress HDM\Documents

Contains the technical documentation for the
HDM application

TekExpress HDM\Examples

Contains various support files

TekExpress HDM\ICP Contains instrument and HDM application-
specific interface libraries
TekExpress HDM\Lib Contains utility files specific to the HDM

application

TekExpress HDM\Report Generator

Contains style sheets for report generation

TekExpress HDM\Tools

Contains instrument and HDM application-
specific files

TekExpress HDM Advanced Analysis and Compliance Solution
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See Also  View test-related files

File name extensions

The TekExpress HDM software uses the following file name extensions:

File name extension Description

.TekX Session files are saved in this format but the extensions may not
be displayed

.py The test sequence file

Xml The encrypted XML file that contains the test-specific

configuration information
The log file extension is also xml

wim The test waveform file

.mht Test result reports are saved in this format by default. Test
reports can also be saved in MHTML or PDF formats.

.pdf Test report can also be saved in pdf format.

fit Filter file used with transmitter tests

See Also  Application directories and usage
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Installing the software

Compatibility = The TekExpress HDM application runs on the following Tektronix oscilloscopes:
= DPO/DSA/MSO72004/C, DPO/DSA/MS0O71604/C Digital Oscilloscopes

with Option DJA

= DPO/DSA73304D and DPO/DSA72504D Digital Oscilloscopes with Option
DJA

= DPO/MSO72304DX, DPO/MSO72504DX, DPO/MS073304DX with
Option DJA

NOTE. You can also use a 12.5 GHz bandwidth oscilloscope, but there may be a
10% variation in the measurement result.

See Also. Minimum system requirements

Minimum system  The following table shows the minimum system requirements for an oscilloscope
requirements  to run TekExpress.

Table 7: System requirements

Component Description

Oscilloscope BW = 16 GHz, 16 M Record Length/Ch - Opt.
4M/2XL or more (for Eye Diagram and Jitter
tests), and 20XL for Inter Pair Skew tests

For a list of compatible oscilloscopes, see

Compatibility.
Processor Same as the oscilloscope
Operating system Same as the oscilloscope
Memory Same as the oscilloscope
Hard disk Same as the oscilloscope
Display Same as the oscilloscope '

I If TekExpress is running on an instrument having a video resolution lower than 800 x 600 (for example, a sampling oscilloscope), it is recommended
that you connect a secondary monitor, which must be enabled before launching the application.
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Component Description

Software = TekExpress HDM Advanced analysis and

Compliance software

= DPOJET, Jitter and Eye Diagram Analysis
Tool Ver 6.1.1.4 and above for Win
7 oscilloscopes

= Microsoft Internet Explorer 6.0 SP1 or later

= Microsoft Photo Editor 3.0 or equivalent
software for viewing image files

= Adobe Reader 8.0 or equivalent software
for viewing portable document format (PDF)
files

Probes = Four differential probes — P7313SMA for

Single-Ended and Differential tests

HDM sources = HDM Tx DUTs

= HDM Ref waveforms

TDR tests = Oscilloscope — DSA8200 or equivalent with

80E03 and 80E04 modules and I-Connect
software

HDM Generator for Sink = Two AWG70002A with option 01, 03 and

225 or two AWG7122C with option 1, 2/6,
8

= One AFG3102/AFG3102C/AFG3252/
AFG3252C

HDM fixtures HDM fixture kits from Tektronix
= TF-HDM-TPA-S fixture
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Component Description
HDM accessory kit ( to be used with AWG) TF-HDM-DS-Acc kit from Tektronix contains the
following:

= Eight Bias Tees from Mini-Circuits —
ZX85-12G-S+

= Two 120 ps TTC filter from Pico Second
Pulse Labs (5915-100-1200)

Other devices = Microsoft compatible mouse or compatible
pointing device
= Four USB ports (two USB ports minimum)

= PCI-GPIB or equivalent interface for
instrument connectivity 2

= |0 SMA cables, 174-1428-xx
=  Three BNC cables

= BNC T connector

= Three BNC-to-SMA adapter

= External power supply PWS4721/
PWS4602/PWS4323/PWS4305/PWS4205

= Any approved DDC Master
= Any approved EDID analyzer

See Also. Compatibility

Windows 7 user accounts  Windows 7 instruments need to have the User Account Control Settings set to
Never Notify. To set User Account Control Settings:

1. Go to Control Panel > User Accounts > Change User Account Control
settings.

2. set it to Never Notify as shown in the image.

2 If TekExpress is installed on a Tektronix oscilloscope, the virtual GPIB port will be used by TekExpress for communicating with oscilloscope
applications. If external GPIB communication devices such as USB-GPIB-HS or equivalent are used for instrument connectivity, ensure that the Talker
Listener utility is enabled in the DPO/DSA oscilloscope's GPIB menu. For ease of use, connect to an external (secondary) monitor.
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Install the software

1% User Account Control Settings = | B |G

Choose when to be notified about changes to your computer

User Account Control helps prevent potentially harmful programs from making changes to your computer,

Tell me more about User Account Control settings
Always notify
- - Never notify me when:
* Programs try to install software or make changes to
my computer
- - ® Imake changes to Windows settings
ﬂ Mot recommended. Choose this only if you need to
use programs that are not certified for Windows 7
—- because they do not support User Account Centrol.
Mever notify

Cancel

See also. Supported oscilloscopes

The software can be installed on any compatible instrument running Windows 7.

1. Close all applications (including the TekScope application).

2. Go to the www.tek.com Web site and search for HDMI to locate the

installation file. Download the file HDM webInstaller.exe.

Double-click the executable file to extract the installation files. After
extraction, the installer launches and displays the InstallShield Wizard.

The software automatically installs in the following location:

m  C:\Program Files\Tektronix\TekExpress\TekExpress HDM

The installer updates the TekScope Analyze menu to include TekExpress

HDM:

MyScope | Analyze | Utilities | Help n

Search...

Mark...

Jitter and Eye Analysis (DPOJET)

Protocol Decode Event Tabie

HDMI Compliance Test Software(1.4)

TekExpress MHL

TekExpress Thunderbolt

TekExpress SAS

TekExpress HDM
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See Also. Minimum system requirements

Compatibility

Activate the license  Activate the license using the option installation wizard on the oscilloscope.
Follow these steps to activate the TekExpress HDM license:

1. From the oscilloscope menu bar, click Utilities > Option Installation.

The TekScope Option Installation wizard opens.

2. Instructions for using the Options Installation window to activate licenses for
installed applications is provided in the oscilloscope online help. Press the F1
key on the oscilloscope keyboard to open the Option Installation help topic.
Follow the directions in the topic to activate the license.

See Also. View Version and License Information
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View version and license
information

Use the following instructions to view application version information and
version information for the application modules such as the Programmatic
Interface and the Programmatic Interface Client.

To view version information:

From the Options menu, select About TekExpress.

- About Tektronix TekExpress HOM

.

TekExpress

Automated Solutions A |
Tektronix

To view license information:
1. From the oscilloscope Help menu, select About TekScope.

The Options section in the dialog box displays a list of installed options,
including TekExpress HDM.

2. To view the Option key, look in the Option Installation Key section. When
finished, click OK to close the dialog box.

See Also. Activate the license

Options menu
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Run the application

To run the HDMI application, do either of the following:

= Select Analyze > TekExpress HDM from the TekScope menu.
= Double-click any saved HDMI session file.

When you open the application after installation, the application checks for a file
called Resources.xml located in the C:\Users\<username>\My

Documents folder. The Resources.xm] file gets mapped to the X: drive when
the application launches. Session files are then stored inside the X : \HDM folder.
The Resources.xm] file contains information about available network-
connected instruments. If this file is not found, the application runs an instrument
discovery program before launching HDM to locate available instruments.

If the application license was not installed using the TekScope menu Utilities >
Option Installation selection, you can open the application up to 10 times in
evaluation mode. Each time you open the application without supplying a valid
license key, one of the free trials is used.

Exit the application

Use the following method to exit the application:

" aul)
Click 0 on the application title bar.

2. Do one of the following:

= [fyou have an unsaved session or test setup open, you are asked to save
it before exiting. To save it, click Yes. Otherwise click No. The
application closes.

= A message box appears asking if you really want to exit TekExpress. To
exit, click Yes.

NOTE. Using other methods to exit the application results in abnormal
termination of the application.
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Application controls and menus

Application controls  Table 8: Application control descriptions

Item Description

Options menu Opens the Options menu for access to global controls

Panels Visual frames with sets of related options

Command buttons Buttons that initiate an immediate action such as the Start, Stop,
Pause, Continue, and Clear command buttons

Start button

Start

Starts continuous measurement acquisition and analysis. If prior
acquired measurements have not been cleared, the new
measurements are added to the existing set.

Stop button

Stop

e

Stops (aborts) the current measurement acquisition.

Pause \ Continue button

Pause Continue

G iy

Use the Pause button to temporarily interrupt the current
acquisition. When a test is paused, the button name changes to
Continue.

Clear button

Clear

Clears all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an
existing measurement, also clears measurements. This prevents
the accumulation of measurement statistics or sets of statistics
that are not coherent. This button is available only on the Results
panel.
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Item Description

(o)

This button is available only on the Status panel.

This button is available only on the Status panel.

Clear Log

Save

Application window move icon

Place the cursor over the three-dot pattern in the upper left
corner of the application window. When the cursor changes to a
hand, drag the window to the desired location.

Options menu  Options menu overview. The Options menu is located in the upper right corner of
the application.

The Options menu has the following selections:
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Options menu

o [

- Default Test Setup
Open Test Setup
Save Test Setup
Save Test Setup As
2.0 Open Recent k

Instrument Contraol Settings
Keep On Top
Email Settings

Help
About TekExpress

Menu Function

Default Test Setup Opens an untitled test setup with defaults selected

Open Test Setup Opens a saved test setup

Save Test Setup Saves the current test setup selections

Save Test Setup As Creates a new test setup based on an existing one

Open Recent Displays a menu of recently opened test setups from which to
select

Instrument control settings Shows the list of instruments connected to the test setup and
allows you to locate and refresh connections to connected
instruments

Keep On Top Keeps the TekExpress HDM utility on top of other open windows
on the desktop

Email settings dialog box Use to configure email options for test run and results
notifications

Help Displays TekExpress Help

About TekExpress = Displays application details such as software name, version

number, and copyright
= Provides access to software version and license information
for your HDM installation

= Provides a link to the Tektronix Web site

See also. Application controls
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Instrument control settings. Use the TekExpress Instrument Control Settings
dialog box to search for and list the connected resources (instruments) found on
specified connections (LAN, GPIB, USB, and so on) and each instruments
connection information. You access this dialog box from the Options menu.

TekExpress Instrument Control §

ANGT122C | BO30 56
DPOTIZ04D Flash Failed
DPOTIZ040 200020
MESOT13540 C250009
ANGTIIC BOsME
DPOT004C 8130216
ANGT 3G BO30149

ated  Octobes 24, 2013 00:54:43 " Close |

Use the Instrument Control Settings feature to and view instrument connection
details. Connected instruments displayed here can be selected for use in the
Global Settings tab in the configuration section. See step 1 of Configure Tests for
details.

See also. Options menu overview

Email settings dialog box overview. Use the Email Settings dialog box to enable
HDMI to send an email message when a test completes, produces an error, or
fails. Select the type of test run information to attach to the email (such as test
reports and test logs), the email message format, and the email message size
limit.

Open the Email Settings dialog box from the Options menu.

NOTE. Recipient email address, sender’s address, and SMTP Server are
mandatory fields.
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See also. Configure email settings

Options menu

Select test notification preferences

Configure email settings. To be notified by email when a test completes, fails, or
produces an error, configure the email settings.

1. Select Options > Email Settings to open the Email settings dialog box.

2. (Required) For Recipient email Address(es), enter one or more email
addresses to which to send the test notification. To include multiple
addresses, separate the addresses with commas.

3. (Required) For Sender’s Address, enter the email address used by the
instrument. This address consists of the instrument name, followed by an
underscore, followed by the instrument serial number, the @ symbol and
then the email server used. For example:

DPO72004C _B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:
= Reports: Attach the test report to the notification email.

= Status Log: Attach the test status log to the notification email. If you
select this option, then also select whether you want to receive the full
log or just the last 20 lines.
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Setup panel overview

Application basics

6. Inthe Email Configuration section:
= Select the message file format to send: HTML (the default) or plain text.

= Enter a maximum file size for the email message (message plus
attachment files). Messages with attachments larger than this limit will
not be sent. The default is 5 MB.

= Enter the number in the Number of Attempts to Send field, to limit the
number of attempts that the system makes to send a notification. The
default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.

Source

The Setup panel contains sequentially ordered tabs that help guide you through a
typical test setup process.

Set the DUT parameters.

Select test(s).

Set lane acquisition source.
Configure the selected tests.

Select test notification preferences.

Items selected in a preceding Setup tab may change options available in the
following tabs. You can switch between the tabs in any order to modify your test
parameters.

Sink

The Setup panel contains sequentially ordered tabs that help guide you through a
typical test setup process.

Set the DUT parameters.
Select test(s).
Configure the selected tests.

Select test notification preferences.
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Set DUT parameters

30

Items selected in a preceding Setup tab may change options available in the
following tabs. You can switch between the tabs in any order to modify your test

parameters.

Use the Setup panel DUT tab to select parameters for the device under test. The
settings are global and apply to all tests for the current session. DUT settings also
affect the list of available tests in the Test Selection tab.

Source.
1. Click Setup > DUT.

a. Suite > Source

_VgTekExpress HDM - H: v | °

DUTID DUTOO1

(]

Device |HDM Physical Layer Solution | v ‘

Suite |Source

| ¥ | Version|CTS 20 |¥

= Acquire live wavefarms

Viow [Compiarce ||

Device Profile

Termination Source
Internal

VTerm (V) 33
Probe Attenuation (<)
Differential

Number of Lanes to Test

s Lanss v

Selected Test Lanes
ClockDOD1D2

125 |v]
Single-Ended

Use pre-recorded waveform files

Data Rate (Gbps)
Highest 5.94
Lowest 3n

TEit for High Data Rate (ps)
TBit for Low Data Rate (ps)
Recalc TBit

0.0000
0.0000

Table 9: DUT tab settings (Source)

Setting

Description

Acquire live waveforms

Acquire active signals from the oscilloscope
for testing.

Use pre-recorded waveform files

Run tests on a saved run session file.
Select a run session file from the list.
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Setting

Description

View

Determines where to access the test
configuration settings:

= Compliance: View configuration
settings by clicking Setup > Test
Selection > Configure

= Advanced: Enables the Setup >
Configuration tab in which to view
configuration settings.

Termination Source

Internal\External Other\Tektronix Power
Supply

Data Rates

Highest: Select the Highest data rate to
include in the tests.

Lowest: Select the Lowest data rate to
include in the tests

TBit For High Data Rate (ps)

Sets the TBit calculated for highest data
rate

TBit For Low Data Rate (ps)

Set the TBit calculated for lowest data rate

Probe Attenuations (X) Differential: 12.5/2.5
Single-Ended: 12.5/2.5

Recalc TBit Check or Uncheck Recalc TBit. TBit Should
be calculated for at least 1 Time.

Number of Lanes to Test Select the number of lanes to be tested:

1 Lane /2 Lanes /3 Lanes /4 Lanes

b. Suite > Sink - Electrical

_-./},’TekExpless HDM - H::: v | e

DUTID

(e

Device |HDM Physical Layer Solution | v ‘

Suite |Smk Electrical

Device Profile

| ¥ | Version|CTS 2.0 |¥

Dala Rate (Gbps)

13840x2160p GRAY VIC97 8Bit4... | ¥ |

Terminaton Soure Externsl | v

Format
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Table 10: DUT tab settings (Sink - Electrical)

Setting Description

Termination Source If Tektronix Power Supply is connected, select
Termination source as “Tektronix Power Supply’ or
“External”. Or It will be “External” only.

Data Rate (Gps) Select data rate from Device Profile

Format Select format from Device Profile

¢. Suite > Sink - Protocol

‘/A,’TekExpress HDM - (Untitled)* m

DUTID CUTOO @

Device ‘HDM Physical Layer Solution ‘ v |

suite  [Sink Protocol v | version cTS 2.0 |7 |

Device Profile

Termination Source | External n
n Preferences

Table 11: DUT tab settings (Sink - Protocol)

Setting Description

Termination Source If Tek Power Supply is connected, select Termination
source as “Tek Power Supply’ or “External”. Or It will be
“External” only.

2. (Optional) Enter the ID for the device. The default value is DUTO001. The
DUT ID parameter is added to reports.

3. (Optional) To add comments to the test report, click the note pad icon (2) to
the right of the DUT ID field. Enter comment text up to 256 characters. To
enable or disable displaying comments in the test report, see Select report
options.

4. Select from the following parameters. Settings that do not apply to
compliance testing cannot be changed and are grayed out.
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Selecttests  Use the Test Selection tab to select the tests to run on the connected DUT.

1. Click Setup > Test Selection.
Sink Electrical

HDM Physical Layer Solution : Sink Electrical : CTS 2.0

=[] Sink Electrical
HF2-1- Min/Max Differential Swing Tolerance

F2-2- Intra-Pair Skew
HF2-3- Jitter Tolerance

Test Description

Please selact a test name to view its Description é

Sink Protocol

HDM Physical Layer Solution : Sink Protocol : CTS 2.0

[=+{w] Sink Protacal
HF 2-6: Sink Video Timing-8G-2160p 24 hit Color Depth
-- HF2-7: Sink Video Timing -6G -2160p Deep Colar
-- HF 2-8: Sink Video Timing -6G -2160p 30
F2-23: 8ink Pixel Decoding YCBCR 4:2:0
F2-24: 5ink Pixel Decoding YCBCR 4.2:0 Deep Color
F2-24: Sink Video Timing -21:9
-- F2-36: SinkVideo Timing -8G Mon -2160p 24hit Color Depth
HF2-37: 8ink video Timing -6G Non-2160p Deep Color
-- HF 2-38: Sink video Timing -8G Non -2180p 30

Test Description

This test Confinms that the Sink DUT Supports
YChCr 4:2:0 Pixel Decoding and Signaling.
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2. Select the test(s) to run:
m  Click one or more check boxes adjacent to each test.
= Click Deselect All to deselect all tests. All tests are selected by default.
= Click Select Required to select all tests that are required for compliance.
= Click Select All to select all tests.
3. Configure the test(s):

= Click Configure to open the configuration settings for a selected test.

NOTE. The Configure button is not displayed if the View in the DUT tab
is set to Advanced.

m  Click Schematic to display a schematic diagram that shows the DUT test
setup. Use the diagram to verify the test setup before running the test.

Set acquisition parameters  Use the Acquisitions tab to set the signal source (channel) used to acquire data.
(source only) Acquisition options are available only when acquiring a live waveform.

1. Click Setup > Acquisitions.

/. TekExpress HDM - :

DuT HDM Physical Layer Solution : Source : CTS 2.0

W
Lane Source Lane Source
Test Selection | Clock  CH1 0o CH2 e

Acq Source Lane Source Difierential n
l : uisitions .
CH3 CH4 |v/|Enable Fitter

Test Name Acquisition |
b HF1-2- TRISE, TFALL Clock : Short Record-length for Rise F
HF1-2- TRISE, TFALL D0 : Short Record-length for Rise Fall
HF1-2- TRISE, TFALL D1 : Short Record-length for Rise Fall
HF1-2- TRISE, TFALL D2 : Short Record-length for Rise Fall
HF1-5- Differential Voltage Clock : Short Record-length for Differe
HF1-5- Differential Voltage D0 : Short Record-length for Differenti
HF1-5- Differential Voltage D1 : Short Record-length for Differanti
HF1-5- Differential Voltage D2 : Short Record-length for Differenti

it £ et et ek ok bt et bt - i
e [ s |

|_ Show Acquire Parameters

2. Select Source field to select the oscilloscope channels to use for those lanes.

3. Select probe type from Probe Type field as Differential, Single-Ended, or
Eye-Diagram.
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4. Check or uncheck the Enable Filter check box and configure the Filter
Configuration by clicking the Filter Config button and choose from the
displayed field.

5. Select Acquire Step By Step to have the software prompt you to continue
after each phase of the test completes.

Set test notification ~ Use the Preferences tab to set the application to send an email when a test
preferences measurement completes:

1. Click Setup > Preferences.

2. Select the Email Test Results when complete check box in the Email
Settings dialog box. Click Email Settings to configure the email settings.

See also. Select report options

Configure test parameters  About configuring test parameters (source only). Use the configuration settings to
view the measurement parameters for selected tests. How the test configurations
are accessed depend on the View selected in the DUT tab.

= [fyou selected Compliance View in the DUT tab, then in the Test Selection
tab, select the desired test in the list and then click the Configure button.

= [fyou selected Advanced View in the DUT tab, click the Configuration tab
in the Setup panel.

See also. Configure tests parameters

Configure test parameters. The Configuration parameters let you set global and
individual test parameters. To return to test selection from the Configuration tab
or panel, click the Test Selection button.

NOTE. You cannot change test parameters that are grayed out.

Source and Sink.
1. Modify Global settings as desired:

m  To select the instruments for testing, click Global Settings. In the
Instruments Detected section, click in the shaded areas to activate the
drop-down lists and select an instrument. If you do not see the desired
instrument in the list, see Instrument control settings.

2. To modify any individual test measurement settings, click Measurements,
select the test in the tree view, and change the settings.

Common test parameters. The following table lists the settings and parameters
common to all tests.
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Table 12: Common parameters and values

Parameter type

Parameter

Mode

Determines whether test parameters are in
compliance mode or can be edited (User
Defined Mode).

= Compliance: Most test parameter values
cannot be edited.

=  User Defined: Most test parameter values
can be edited.

Global Settings

These settings apply to all tests selected for the
current session. You can change only some of
these settings.

m  Scope Settings: Specifies the instrument
channel to use as the source for the trigger.
This can be changed.

= Channel Amplitude: The value of the
amplitude to be set for the selected
channel.

Measurements

These settings apply to the test selected in the
tree view of the configuration section.

Limits Editor (Source only)

Shows the upper and lower limits for the
applicable measurement using different types of
comparisons.

In Compliance Mode, you are able to view the
measurement high and low limits used for the
test selected in the tree view of the
Measurements tab.

When running tests in User Defined Mode, you
can edit the limit settings in the Limits Editor.
When running tests in User Defined Mode, the
cells in the Limits Editor table are active for
editing so you can change parameters.

Test Hame

ML VL nd saing

W2 TRISE AL

HI3- Wnter- P Sk
W3- Intra-Pas Shew

When running tests in User Defined Mode, the
cells in the Limits Editor table are active for
editing so you can change parameters.
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Status panel overview

The Status panel provides status on test acquisition and analysis (Test Status tab)
and a listing of test tasks performed (Log View tab). The application opens the
Test Status tab when you start a test run. You can select the Test Status or the
Log View tab to view these items while tests are running.

The Test Status tab lists a high level status for each test.
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Table 13: Test Status tab

Column Description
Test Name Name of the test
Acquire Status, Analysis Status Status of the signal acquisition or test analysis

= To be started
= |nprogress
= Completed

= Aborted

NOTE. Sink tests have a minimal set of status
indicators.

HF1-1- VL 88 VSwing

W12 TREE, TFALL Saeet Rncordlength o e Fal Yo b atarted Té be stacted

HF1-3- rtee-Par Shaw Soon Rucootiengh formmarPar o L
Stew

HF 1.4 tra.Par Shew 20 Rocorblongh T EAPUY L e

HF1E Coct Duty Oyt sad CockRate Shom Recont-length for Clses
Outy Cycle

MFL.T. Cloct Jmer Sron Recorg-lengm for Clact
L

To te atarted To be atated

To te started To b ataried

WF 13- Data Eye Dagram Stort Recordngh forData bye 10

To be staried

| HP L3 Deftererdal Votage mnm\\:—z’?m To be staried To e stated
| @0

i WILE VL and VEwing Sort Record-length for View To be staded To be stated
w2 TAGE, TPALL Sron Record-engn for Rme Fat To te started To be stated

P13 bteePar Shew Sort Recondlengt formerbar oo\ o0

R §ode tra-Pur Shaw Shont Rmcordengn forbabar oo

W16 Coch Duty Cye 4nd Cock Rate  Short Recorg-lengen for Clock
Dty Cycie
Seon Recars-lengn for Clock
oar

To be started

/| TestHame Analysis Status.
a
HF2-1- Min/Max Differential Swing Tolerance To be started.
HF2-2- Intra-Pair Skew To be started.

HF2-3- Jitter Tolerance To be started
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Column Description

The Log View tab provides a list of the actions executed during the test. Use this
information to review or troubleshoot tests.

Table 14: Log View fields

Item Description

Message History Displays all run messages with timestamp
information.

Show Detailed Log Records a detailed history of test execution.

Auto Scroll Sets the program to automatically scroll down

the Message History window as information is
added to the log during the test.

Clear Log Clears all messages in the Message History
window.
Save Saves the log file as a text file for examination.

Displays a standard Save File window and
saves the status messages in the file that you

specify.
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See also

Results panel

Results panel overview

40

View test results

When a test finishes, the application switches to the Results panel to display a
summary of test results. Set viewing preferences for this panel from the
Preferences menu in the upper right corner. Viewing preferences include showing
whether a test passed or failed, summary results or detailed results, and enabling
wordwrap. For information on using this panel, see View test results.

Sink results

Test Name

Timing-6G-2160p 24 bit  24Bit RGB 60HZ

Color Depth

HF2.6: Sink Video SVT2160BCD 3840x2160p VICS7 GRAY
Timing-6G-2160p 24 bit  24Bit RGB 60Hz

Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY
Timing-6G-2160p 24 bit  24Bit RGB 50Hz ) Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY
Timing-6G-2160p 24 bit  24Bit RGB 50Hz & Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 3840x2160p VIC96 GRAY|
| Timing-6G-2160p 24 bit | 24Bit RGB 50Hz (@ Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 60Hz & Pass
Color Dept

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-5G-2160p 24 bit  GRAY 24Bit RGB 60Hz & Pass
Color Depth

HF2-6: Sink Video SVT2160BCD 4096x2160p VIC102
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 60Hz & Pass
Color Depth

HF2.6: Sink Video SVT2160BCD 4096x2160p VIC101
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 50Hz & pass
Color Dept

HF2.6: Sink Video SVT2160BCD 4096x2160p VIC101
Timing-6G-2160p 24 bit  GRAY 24Bit RGB 50Hz & Pass
| Color Depth

Source results

ATH047 N
6

168350 371
ps Gops

TekExpress HDM Advanced Analysis and Compliance Solution



Application basics

View test results ~ When a test finishes, the application switches to the Results panel, which displays
a summary of test results. The overall test result is displayed at the top left of the
Results table. If all of the tests for the session pass, the overall test result will be
Pass. If one or more tests fail, the overall test result will show Fail.

Each test result occupies a row in the Results table. By default, results are
displayed in summary format with the measurement details collapsed and with
the Pass/Fail column visible. Change the view in the following ways:

= To expand all tests listed, select View Results Details from the Preferences
menu in the upper right corner.

= To expand and collapse tests, click the plus and minus buttons.
= To collapse all expanded tests, select Preferences > View Results

Summary.

m  To remove or restore the Pass/Fail column, select Preferences > Show Pass/
Fail.

= To enable or disable the wordwrap feature, select Preferences > Enable
Wordwrap.

= To expand the width of a column, place the cursor over the vertical line that
separates the column from the column to the right. When the cursor changes
to a double-ended arrow, hold down the mouse button and drag the column to
the desired width.

= To sort the test information by column, click the column head. When sorted
in ascending order, a small up arrow is displayed. When sorted in descending
order, a small down arrow is displayed.

m  To clear all test results displayed, click Clear.

See also. View a report

View test-related files  Files related to tests are stored in the My TekExpress\HDM folder. In the HDM
folder, each test setup has a test setup file and a test setup folder, both with the
test setup name. The test setup file is preceded by the HDM icon and usually has
no visible file extension.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions. The default is DUTO001.

Inside the DUTO001 folder are the session folders and files. Each session has a
folder and file pair, both named for the test session using the naming convention
(date) (time). Each session file is stored outside its matching session folder.

20110811 162533
20110811 165306
20110811 165407
/L 20110811_162533
/& 20110811_165306
/L 20110811 _165407
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The first time you run a new, unsaved session, the session files are stored in the
Untitled Session folder located at . .\My TekExpress\HDM. When you
name and save the session, the files are placed in a folder with the name that you
specify.

See also. File name extensions

Reports panel

Reports panel overview  Use the Reports panel to open reports, name and save reports, select report
content to include, and select report viewing options.

For information on setting up reports, see Select report options. For information
on viewing reports, see View the report.
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Application basics

Use the Reports panel to select which test information to include in the report,
and the naming conventions to use for the report. For example, always give the
report a unique name or select to have the same name increment each time you
run a particular test. Generally, you would select report options before running a
test or when creating and saving test setups. Report settings are included in saved

test setups.

In the Reports panel, select from the following options:

Table 15: Report options

Setting

Description

Generate new report

Creates a new report.

Replace current test values with the new results

Replaces the previous test results with the latest
test results. Newly added tests results are
appended to the end of the report.

Append with previous run session

Appends the last run session and the previous
run session.

Report name

Displays the name and location from which to
open a report. The default location is at \My
TekExpress\HDM\Untitled Session. The report
file in this folder gets overwritten each time you
run a test unless you specify a unique name or
select to auto increment the report name.
Change the report name or location.

Do one of the following:

m  In the Report Name field, type over the
current folder path and name.

= Double-click in the Report Name field. Make
selections from the popup keyboard and
then click the Enter button.

Be sure to include the entire folder path, the file
name, and the file type. For example: C:
Documents and Settings\your user name\My
Documents\My TekExpress\HDM Tx
DUTO001_Test_211.mht.

NOTE. You cannot change the file location using
the Browse button.

Open an existing report.

Click Browse, locate and select the report file
and then click View at the bottom of the panel.

Save as type

Saves a report in the specified file type. Lists
supported file types to choose from.

NOTE. If you select a file type different from the
default, be sure to change the report file name
extension in the Report Name field to match.
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Setting Description

Auto increment report name if duplicate Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUT002,
DUTO003. This option is enabled by default.

Include pass/fail results summary Sets the application to include the color block
labeled Test Result (indicating whether the test
passed or failed) in the report. For details, see
Report Contents in View a report.

Include detailed results Sets the application to include parameter limits,
execution time, and test-specific comments
generated during the test.

Include plot images Sets the application to include plotted diagrams.

Include setup configuration Sets the application to include information about
hardware and software used in the test in the
summary box at the top of the report.
Information includes: the oscilloscope model and
serial number, probe model and serial number,
the oscilloscope firmware version, SPC and
factory calibration status, and software versions
for applications used in the measurements.

Include Complete Application Configuration Sets the application to include a table listing
general, common, and acquired parameters
used in the test. This option is disabled by
default.

Include user comments Select to include any comments about the test
that you or another user added in the DUT tab of
the Setup panel. Comments appear in the
Comments section under the summary box at
the beginning of each report.

View report after generating Automatically opens the report in your Web
browser when the test completes. This option is
selected by default.

See also. View a report
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View areport  The application automatically generates a report when test analysis is completed
and displays the report in your default Web browser (unless you cleared the View
Report After Generating check box in the Reports panel before running the
test). If you cleared this check box, or if you want to view a different test report,
do the following:

1. Click the Reports > Browse button and locate and select the report file to
view.

NOTE. If you did not save the test setup after running the test and you either
closed the application or you ran another test, the report file was not saved.

2. At the bottom of the Reports panel, click View.

For information on changing the file type, file name, and other report options, see
Select report options.

Report contents A report shows specified test details, as defined in the Reports panel.

Setup configuration information

Setup configuration information is listed in the summary box at the top of the
report. This information includes the oscilloscope model and serial number,
probe model and serial number, and software versions. To exclude this
information from the report, clear the Include setup configuration check box in
the Reports panel before running the test.

Source
Tektroni TekExpress HDM
Source Test Report
o
e T
Dence Type
TekExpress Version Scope E /W Version
Spec version DROKT version
Overall Complianse Mode Yes Probe) Model
Execution Mode Lve Probel Serial Number
Overall Execution Time L0748 Pranhe? Mode!
Overall Test Result Fall Probe? Serial Number
Probes Model
Probes Serial Number
Probed Mode!
Pribstsatnie {wa
DT COMMENT. | Ceneral Comment - HOMZ.5 Source
.
Sink
Tektronix: TekExpress HDM

Sink Electrical Test Report

setup
DUT ID DUT001 Scope Model DPO73304D
Date /Time 2014-05-23 11:37:54 Scope Serial Number Flash Failed
Device Type HDM Physical Layer Solution SPC, FactoryCalibration PASS:PASS
TekExpress Version HDM:1.0.1.235 Framework:3.0.1.43 | Scope F/W Version 7.1.1 Build 1
Spec Version cT152.0 Master AWG Model AWG70002A
Overall Compliance Mode No Master AWG F/W Version 2.0.0211
Execution Mode Live Slave AWG Model AWG70002A
Overall Execution Time 0:09:59 Slave AWG F/W Version 2.0.0211
Overall Test Result Pass AFG Model AFG3252C
DUT COMMENT: General Comment - HDM2.0 Sink Electrical

User comments

If you selected to include comments in the test report, any comments you added
in the DUT tab of the Setup panel appear in the Comments section directly below
the summary box.
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Cornrmerts

Test results

This table lists the tests results. The contents of this table depend on the
selections made in the Reports panel before running the test (Include pass/fail
results summary, Include user comments, Include detailed results, Include setup

configuration, and Include user comments).

If Include plots images is selected, then measurement waveform plots are shown
below the test results table.

HF 1-5- Differential Voltage
TP 1 EyeDiagram- D0

et T i
ZALHED e XX =S
i -
X L1} i ] -] e e

See also. View test results

View test-related files
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About the programmatic interface

The Programmatic interface allows you to seamlessly integrate the TekExpress
test automation application with the high-level automation layer. This also allows
you to control the state of the TekExpress application running on a local or a
remote computer.

For simplifying the descriptions, the following terminologies are used in this
section:

= TekExpress Client: A high-level automation application that communicates
with TekExpress using TekExpress Programmatic Interface.

= TekExpress Server: The TekExpress application when being controlled by
TekExpress Client.

TekExpress leverages .Net Marshalling to enable the Programmatic Interface for
TekExpress Client. TekExpress provides a client library for TekExpress clients to
use the programmatic interface. The TekExpress client library is inherited

from .Net MarshalByRef class to provide the proxy object for the clients. The
TekExpress client library maintains a reference to the TekExpress Server and this
reference allows the client to control the server state.

et C# Het VB et Web Test3tand
Client Client Chent Client
Fy Fy
‘\‘ v v /'
TekEzpressClient Library
b
¥
TekExpress
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See also  Requirements for developing TekExpress client
Remote proxy object
Client proxy object

To enable remote access

To access and remotely control an instrument using the TekExpress
programmatic interface, you need to change specific firewall settings as follows:

1. Access the Windows Control Panel and open the Windows Firewall tool
(Start > Control Panel > All Control Panel Items > Windows Firewall).

2. Click Advance Settings > Inbound Rules.

3. Scroll through the Inbound Rules list to see if the following items (or with a
similar name) are shown:

= TekExpress HDM
= TekExpress

o Windows Firewall with Advanced Security [=

File Action View Help

=@ = HE
& Inbound Rules Name : Enabled  Action  Override *
& Outbound Rules | @TekExpress CEL-VSR Yes Allow  No

& Connection Securit| @ gnsjaRs Yes Allow  No
> & Monitoring @30SINB Yes Allow  No
@aw32 Yes Allow  No

4. If both items are shown, you do not need to set up any rules. Exit the
Windows Firewall tool.

5. If one or both are missing, use the following procedure to run the New
Inbound Rule Wizard and add these executables to the rules to enable
remote access to the TekExpress application.

6. On the client side include Client application.exe through which TekExpress
application is remotely controlled. For example if the application is
controlled using python scripts then "ipy64.exe" should be included as part of
Inbound rules.
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Run the New Inbound Rule 1. Click on New Rule (in Actions column) to start the New Inbound Rule
Wizard Wizard.

I | Actions
Action  * || Inbound Rules -
Allow ﬂ Mew Rule, ..
Allow T Filter by Profile 3
Allow

T Filter by State »
Allow
Allow ' Filter by Group »
Allow View »

2. Verify that Program is selected in the Rule Type panel and click Next.

3. Click Browse in the Program panel and navigate to and select one of the
following TekExpress applications (depending on the one for which you need
to create a rule):

4. TekExpress HDM.exe

5. TekExpress.exe
NOTE. See for the path to the application files.

6. Click Next.

7. Verify that Allow the connection is selected in the Action panel and click
Next.

8. Verify that all fields are selected (Domain, Private, and Public) in the

Profile panel and click Next.

9. Use the fields in the Name panel to enter a name and optional description for
the rule. For example, a name for the TekExpress HDM application could be
TekExpress HDM Application. Add description text to further identify the
rule.

10. Click Finish to return to the main Windows Firewall screen.

11. Scroll through the Inbound Rules list and verify that the list shows the rule
that you just entered.

& Windows Firewall with Advanced Security = B ="

File Action Wiew Help
es|a@ =]

o Windows Firewall with| [ITISTT T EN

& Inbound Rules Name Group Profle  Enabled  Action
&5 Outbound Rules | @status Port All Yes Allow
# Connection Securit) @TpsCsAB000 Al Yes Allow
» % Monitoring L TekExpress CEI-VSR Yes Allow
L TekExpress PL H Allow

@Tekscope All Yes Allow

@Tekscopel All Yes Allow

@Tektronix VISA Call Monitor Private  Yes Allow

12. Repeat steps / through /1 to enter the other TekExpress executable if it is
missing from the list. Enter TekExpress PI as the name.
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13. Scroll through the Inbound Rules list and verify that the list shows the rule
that you just entered.

14. Exit the Windows Firewall tool.

To use the remote access: 1. Obtain the IP address of the instrument on which you are running
TekExpress HDM. For example, 134.64.235.198.

2. On the PC from which you are accessing the remote instrument, use the
instrument IP address as part of the TekExpress HDM PI code to access that
instrument. For example:

object obj = piClient.Connect(“134.64.235.198”,0ut
clientid);

Requirements for developing TekExpress client

While developing the TekExpress Client, use the TekExpressClient.dll. The
client can be a VB .Net, C# .Net, TestStand or Web application. The examples
for interfaces in each of these applications are in the Samp1es folder.

References required

TekExpressClient.dll has an internal reference to /1dlglib.dll and
IRemotelnterface.dll.

m  [ldiglib.dll has a reference to TekDotNetLib.dll.

m  [Remotelnterface.dll provides the interfaces required to perform the remote
automations. It is an interface that forms the communication line between the
server and the client.

m  [ldiglib.dll provides the methods to generate and direct the secondary dialog
messages at the client-end.

NOTE. The end-user client application does not need any reference to the above
mentioned DLL files. It is essential to have these DLLs (IRemotelnterface.dll,
11dIglib.dll and TekDotNetLib.dll) in the same folder as that of
TekExpressClient.dll.
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Required steps for a client  The following steps are used by the client to programmatically control the server
using TekExpressClient.d1T:

Develop a client Ul to access the interfaces exposed through the server. This
client loads TekExpressClient.d11 to access the interfaces. After
TekExpressClient.d11 is loaded, the client Ul can call the specific functions
to run the operations requested by the client. When the client is up and running, it
does the following to run a remote operation:

1. To connect to the server, the client provides the IP address of the PC where
the server is running.

2. The client locks the server application to avoid conflict with any other Client
that may try to control the server simultaneously. “Lock” would also disable
all user controls on the server so that server state cannot be changed by
manual operation.

If any other client tries to access a server that is locked, it will receive a
notification that the server is locked by another client.

3. When the client has connected to and locked the server, the client can access
any of the programmatic controls needed to run the remote automations.

4. After the client operations finish, the client unlocks the server.

Seealso  HDM application commands flow

Remote proxy object

The server exposes a remote object to let the remote client access and perform the
server-side operations remotely. The proxy object is instantiated and exposed at
the server-end through marshalling.

MarshalByEef

TekExpressClient

TekExpress RemoteProxyOhiject

The following is an example:

RemotingConfiguration.RegisterWellKnownServiceType (typeof
(TekExpressRemoteInterface), “TekExpress Remote interface”,
wellKnownObjectMode.Singleton);
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Client proxy object

52

This object lets the remote client access the interfaces exposed at the server side.
The client gets the reference to this object when the client gets connected to the
server.

For example,
//Get a reference to the remote object

remoteObject =
(IRemoteInterface)Activator.GetObject(typeof(IRemoteInterfac
e), URL.ToString());

Client exposes a proxy object to receive certain information.

MarshalByEef

TekExpress [ chompm p——— TekExpressClient

For example,
//Register the client proxy object

wellKnownServiceTypeEntry[] e =
RemotingConfiguration.GetRegisteredwellknownServiceTypes();

clientInterface = new ClientInterface();

RemotingConfiguration.RegisterWellKknownServiceType(typeof(Cl
ientInterface), “Remote Client Interface”,
wellKnownObjectMode.Singleton);

//Expose the client proxy object through marshalling

RemotingServices.Marshal(clientInterface, "Remote Client
Inteface");

The client proxy object is used for the following:
= To get the secondary dialog messages from the server.

m  To get the file transfer commands from the server while transferring the
report.

Examples
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clientObject.clientIntf.DisplayDialog(caption, msg,iconType,
btnType) ;

clientobject.clientIntf.TransferBytes(buffer, read,
fileLength);

For more information, click the following links:

Secondary dialog message handling

MarshalByEef
¥
Client Proxyobject .
TekEzpress |4 TelExpressClient
T Display Diskogl)
sSecondary Dialog

The secondary dialog messages from the Secondary Dialog library are redirected
to the client-end when a client is performing the automations at the remote end.

In the secondary dialog library, the assembly that is calling for the dialog box to
be displayed is checked and if a remote connection is detected, the messages are
directed to the remote end.

File Transfer Events

When the client requests the transfer of the report, the server reads the report and
transfers the file by calling the file transfer methods at the client-end.
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Client programmatic interface overview

54

The following is an overview of the client programmatic interface:

Start

t

Connect to Remote Object

Get Client ID

Lock Server

iy

| Register for Status Change Notification |

!

| Select the requested tests |

!

| Set the necessary Patameters for eash selected test I

Handler for Status Change Nofification

Status = Wait/ Error’
Run the test

D.A

Get Status Info

;

Get Status

| Do Action based on Status |
No l

Status="Ready’

Set Response

Get Results

Return to Main Flow .

Process the Results

Unlock Server

l Disconnect from Remote Object

Stop Y

1. Connect to a server or remote object using a programmatic interface.

2. Get the client ID that is created when connecting to the remote object. This
client ID is one of the required parameters to communicate with the server.

NOTE. The server identifies the client with this ID only and rejects any
request if the ID is invalid.
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3. Lock the server for further operations. This disables the application interface.

NOTE. You can get values from the server or set values from the server to the
client only if the application is locked.

4. Register for receiving notifications on status change events on the server. To
register you need to give a handler as a parameter. For details, see Handler of
status change notification.

NOTE. Whenever there is a change in the status of the server, all the clients
registered with the server receive a notification from the server.

Select the tests to run through the programmatic interface.
Set the necessary parameters for each test.

Run the tests.

e BN

Poll for the status of the application.

NOTE. Skip this step if you are registered for the status change notification
and the status is Ready.

9. After completing the tests, get the results.
10. Create a report or display the results and verify or process the results.
11. Unlock the server after completing all the tasks.

12. Disconnect from the remote object.

[a—,

Handler of status change Get the status. If the status is Wait or Error, get the information that contains
notification the title, message description, and the expected responses for the status.

2. Perform the actions based on the status information.

Set the response as expected.

See also  HDM application commands flow

Program remote access code example
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Program remote access code example

This code example shows how to communicate between a remote PC and
TekExpress HDM.

Table 16: Remote access code example

Task

Code

Start the application

Connect through an IP address.

m_Client.Connect("Tlocalhost") 'True or False
clientID = m_Client.getClientID

Lock the server

m_Client.LockServer(clientID)

Disable the Popups

m_Client.SetVerboseMode(clientID, false)

Set the DUT ID

m_Client.SetbutIid(clientID, "DUT_Name'")

Select a test

For Source: selectTest(clientId, device, Suite,
test name, true)
m_Client.SelectTest(clientID, "HDM Physical
Layer Solution", "Source", "HF1-2- TRISE,
TFALL", true);

Run with set configurations

m_Client.Run(cTientID)

Wait for the test to complete.

Do

Thread.S1leep(500)
m_Client.Application_Status(clientID)
Select Case status

Case "wait"

Get the current state information

mClient.GetCurrentStateInfo(clientID,
waitingMsbBxCaption, WwaitingMsbBxMessage,
waitingMsbBxButtontexts)

Send the response

mClient.SendResponse(clientID,
waitingMsbBxCaption, waitingMsbBxMessage,
waitingMsbBxResponse)

End Select

Loop Until status = "Ready"

Save results

'Save all results values from folder for current run
m_Client.TransferResult(clientID, logDirname)

Unlock the server

m_Client.UnTockServer(clientID)

Disconnect from server

m_Client.Disconnect()

Exit the application

56
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HDM application commands

HDM application  Click a client action link to see the associated command name, description,
commands flow  parameters, return value, and an example.

Connect through an IP address

Lock the server

Disable the popups

Set or get the DUT ID

Set the configuration parameters for a suite or measurement
Query the configuration parameters for a suite or measurement
Select a test

Select a suite

Run with set configurations or stop the run operation
Handle error codes

Get or set the timeout value

Wait for the test to complete

After the test is complete

Save, recall, or query a saved session

Unlock the server

Disconnect from the server

Connect through anIP | Command name | Parameters Description Return value Example
address Connect() string ipAddress | This method Return valueis | m_Client = new
out string clientlD | connects the client| either True or Client() //m_Client

to the server. Note| False is a reference to
The client provides the Client class in
the IP address to the Client DLL.
connect to the returnval as
server. boolean
The server returnval =
provides a unique m_Client.Connect(
client identification ipaddress,m_client
number when ID)
connected to it.
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string ipAddress

Name Type Direction Description

ipAddress string IN The ip address of the
server to which the
client is trying to
connect. This is
required to establish
the connection between
the server and the

client.
out string clientiD
Name Type Direction Description
clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The server must be active and running for the client to connect to the
server. Any number of clients can be connected to the server at a time

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Lock the server Command name | Parameters Description Return value Example
LockSession() string clientlD This method locks | String value that | m_Client = new
the server. Note | gives the status of | Client() /m_Client
The client must | the operation after | is a reference to
call this method | it has been the Client class in
before running any| performed the Client DLL.
of the remote The return value is| returnval as string
automations. The | "Session returnval =
server can be Locked...” on m_Client.LockServ
locked by only one| success. er(clientlD)
client.
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client tries to lock a server that is locked by another client, the
client gets a notification that the server is already locked and it must wait until
the server is unlocked. If the client locks the server and is idle for a certain
amount of time then the server is unlocked automatically from that client.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Disable the popups

Use these commands to disable popup messages that require user intervention.

Command name | Parameters

Description

Return value

Example

SetVerboseMode() string clientID

bool _verbose

This method sets
the verbose mode
to either true or

String that gives
the status of the
operation after it

m_Client = new
Client() //m_Client
is a reference to

false. has been the Client class in
When the value is | performed the Client DLL.
settotrue,any | When Verbose | returnval as string

message boxes

mode is set to

Verbose mode is

that appear during | true, the return turned on

the application will | value is “Verbose | return=m_Client.S
be routed to the | mode turned on. | etVerboseMode(cli
client machine that All dialog boxes | entlD, true)

is controlling will be shown to | Verbose mode is
TekExpress. client”. turned off

When the value is | When Verbose returnval=m_Clien
set to false, all the | mode is set to t.SetVerboseMod

message boxes
are shown on the
server machine.

false, the return
value is “Verbose
mode turned off.
All dialog boxes
will be shown to
server’.

e(clientID, false)

out string clientiD

Name

Type

Direction

Description

clientlD string out Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,

1065-192.157.98.70

bool verbose

Name Type Direction Description

_verbose bool IN Specifies whether the
verbose mode should

be turned ON or OFF
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command”.

If the server is NOTFOUND the command returns "Server not

found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Set or get the DUT ID Command name | Parameters Description Return value Example
SetDutld() string clientlD This method String that gives | m_Client = new
string dutName | changes the DUT | the status of the | Client() //m_Client
ID of the setup. | operation afterit | is a reference to
The client must | has been the Client class in
provide a valid performed the Client DLL.
DUT ID. Return value is returnval as string
“DUT Id Changed” | return=m_Client.S
0on success etDutld(clientID,de
siredDutld) Note
GetDutld() string clientlD This method gets | String that gives | m_Client = new
string dutld the DUT ID of the | the status of the | Client() //m_Client
current setup. operation afterit | is a reference to
has been the Client class in
performed the Client DLL.
returnval as string
return=m_Client.G
etDutid(clientID,
out Dutld)
out string clientlD
Name Type Direction Description
clientlD string ouTt Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string dutName

Name Type Direction Description
dutName string IN The new DUT ID of the
setup
string dutld
Name Type Direction Description
dutld string ouTt The DUT ID of the
setup

The dutld parameter is set after the server processes the request.

NOTE. If the dutName parameter is null, the client is prompted to provide a valid
DIT ID.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Command name | Parameters Description Return value Example
SetGeneralParam | string clientlD This method sets | String that gives | Sets the value for
eter string device the general the status of the | the general
string suite parameter values. | operation after it | Parameter.
string test __ |hasbeen mClient.SetGener
string NOTE. Use this | performed alParameter(clientl
parameterString | command to select The return value is| D, "HDM Physical
a lane, channel, or| ™ (an empty Layer Solution",
source type. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Voltage
termination
$Internal"
SetAnalyzeParam | string clientID This method sets | String that gives | Sets the value for
eter() string device the configuration | the status of the | the Analyze
string suite parameters in the | operation afterit | Parameter.
string test Analyze panel of | has been mClient.SetAnalyz
string the Configuration | performed eParameter(clientl
parameterString | Panel dialog box | The return value is| D, "HDM Physical
for a suite or " (an empty Layer Solution",
measurement. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Signal Type
$DATA")
SetAcquireParame; string clientlD This method sets | String that gives | Sets the value for
ter() string device the configuration | the status of the | the Acquire
string suite parameters in the | operation afterit | Parameter.
string test Acquire panel of | has been mClient.SetAcquir
string the Configuration | performed eParameter(clientl
parameterString | Panel dialog box | The return value is| D, "HDM Physical
for a suite or " (an empty Layer Solution",
measurement. String) on "Source", "HF1-2-
success. TRISE, TFALL",
"Short Record-
length for VLow
$Record Length
(M)$4"
out string clientiD
Name Type Direction Description
clientlD string ouTt Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string device

Name Type Direction Description
device string IN Specifies the name of
the device

For example "HDM
Physical Layer

Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF 1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye

Diagram"
string parameterString
Name Type Direction Description
parameterString string IN Selects or deselects a
test
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command”.

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Command name | Parameters Description Return value Example
GetGeneralParam | string clientID This method gets | The return value is| Gets the value for
eter() string device the general the general the general
string suite configuration configuration Parameter.
string test parameters fora | parameter fora | mClient.GetGener
string suite or specified suite or | alParameter(client|
parameterString | measurement. measurement that | D, "HDM Physical
is set. Layer Solution",
"Source", "HF1-2-
TRISE, TFALL",
"Voltage
termination")
GetAnalyzeParam | string client/D This method gets | The return value is| Gets the value for
eter() string device the configuration | the configuration | the Analyze
string suite parameters setin | parameter setin | Parameter.
string test the Analyze panel | the Analyze panel | mClient.GetAnalyz
string of the of the eParameter(clientl
parameterString | Configuration Configuration D, "HDM Physical
Panel dialog box | Panel dialog box | Layer Solution”,
for a specified for a specified "Source", "HF1-2-
suite or suite or TRISE, TFALL",
measurement. measurement. "Signal Type")
GetAcquireParam | string clientID This method gets | The return value is| Gets the value for
eter() string device the configuration | the configuration | the Acquire
string suite parameters set in | parameter setin | Parameter.
string test the Acquire panel | the Acquire panel | mClient.GetAcquir
string for a specified for a specified eParameter(clientl
parameterString | suite or suite or D, "HDM Physical
measurement. measurement. Layer Solution",
"Source", "HF1-2-
TRISE, TFALL",
"Short Record-
length for VLow
$Record Length
M)
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device
For example "HDM
Physical Layer
Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"
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string parameterString

Name Type Direction Description
parameterString string IN Selects or deselects a
test

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Query parameter example

returnval=mClient.GetAnalyzeParameter(clientID, "Transmitter", "Drive",
"5.3.9 - Random Jitter (RJ)", "Clock Edge")

Select a test Command name | Parameters Description Return value Example
SelectTest() string clientlD This method String that m_Client = new
string device selects or displays the status| Client() //m_Client
string suite deselects a of the operation | is a reference to
string test specified test. after it has been | the Client class in
bool isSelected | If this Setting performed the Client DLL
parameter is set to| The return value is| returnval as string
true, you can " (an empty For Source:
selecta String) on SelectTest(clientld
measurement. success. , device, Suite,
If this Setting test name, true)
parameter is set to m_Client.SelectTe
false, you can st(clientlD, "HDM
deselecta Physical Layer
measurement. Solution",
"Source", "HF1-2-
TRISE, TFALL",
true);
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out string clientiD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

string device

Name Type Direction Description
device string IN Specifies the name of
the device
For example "HDM
Physical Layer
Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite
For Example "Source";
"Sink Electrical"; "Sink
Protocol"
string test
Name Type Direction Description
test string IN Specifies the name of

the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"
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bool isSelected

Name Type Direction Description
isSelected bool IN Selects or deselects a
test

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Select a suite Command name | Parameters Description Return value Example
SelectSuite() string clientlD This method String that gives | m_Client.SelectSu
string device selects or the status of the | ite(clientlD, "HDM
string suite deselects a operation after it | Physical Layer
bool isSelected | specified suite. has been Solution",
When this performed "Source", true)
parameter is set to| The return value is
true, you can " (an empty
select a suite. String) on
When this success.
parameter is set to
false, you can
deselect a suite.
out string clientlD
Name Type Direction Description
clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string device

Name Type Direction Description
device string IN Specifies the name of
the device

For example "HDM
Physical Layer

Solution”
string suite
Name Type Direction Description
suite string IN Specifies the name of
the suite

For Example "Source";
"Sink Electrical"; "Sink

Protocol"
bool isSelected
Name Type Direction Description
isSelected bool IN Selects or deselects a
test

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Command name

Parameters

Description

Return value

Example

Run()

string clientlD

Runs the selected

String that gives

m_Client = new

run operation tests Note the status of the | Client() /m_Client
After the server is | operation after it | is a reference to
set up and has been the Client class in
configured, runit | performed. the Client DLL.

remotely using this| The return value is| returnval as string
function. "Run started..." on | returnval=m_Clien
success. t.Run(clientID)

m_Client = new
Client() //m_Client
is a reference to

Stop() string clientlD Stops the currently| String that gives
running tests Note | the status of the
operation after it
has been the Client class in
performed the Client DLL.

The return value is| returnval as string

"Stopped..." on | returnval=m_Clien
success. t.Stop(clientID)
out string clientiD
Name Type Direction Description
clientlD string out Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the run is performed, the status of the run is updated periodically
using a timer.

NOTE. When the session is stopped, the client is prompted to stop the session and
is stopped at the consent.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Handle error codes

Get or set the timeout
value

The return value of the remote automations at the server-end is OP_STATUS,
which changes to a string value depending on its code, and returned to the client.
The values of OP_STATUS are as follows:

Code Value Description

-1 FAIL The operation failed

1 SUCCESS The operation succeeded

2 NOT FOUND Server not found

3 LOCKED The server is locked by another
client, so the operation cannot
be performed

4 UNLOCK The server is not locked; lock
the server before performing
the operation

0 NULL Nothing

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another

client”.

If the session is UNLOCKED the command returns "Lock Session to execute the

command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

string time

period specified by
the client. After
this timeout period
expires, the server
is unlocked
automatically.

the status of the
operation after it
has been
performed

On success the
return value is
“TimeOut Period
Changed”.

Command name | Parameters Description Return value Example
GetTimeOut() string clientlD Returns the String that gives | m_Client = new
current timeout | the status of the | Client() /m_Client
period set by the | operation afterit |is a reference to
client has been the Client class in
performed the Client DLL.
The default return | returnval as string
value is 1800000. | returnval=m_Clien
t.GetTimeOut()
SetTimeOut() string clientlD Sets a timeout String that gives | m_Client = new

Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.SetTimeOut(clien
tiD,
desiredTimeOut)
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string time
Name Type Direction Description
time string IN The time in seconds

that refers to the
timeout period

The time parameter gives the timeout period, which is the time the client is
allowed to be locked and idle. After the timeout period if the client is still idle, it

gets unlocked.

The time parameter should be a positive integer; otherwise, the client is prompted
to provide a valid timeout period.

out string clientlD

Name Type Direction Description

clientlD string ouTt Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Wait for the testto =~ The commands in this group execute while tests are running. The
complete GetCurrentStateInfo() and SendResponse() commands are executed when the
application is running and in the wait state.
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Command name | Parameters Description Return value Example
ApplicationStatus() string clientD This method gets | String value that | m_Client = new
the status of the | gives the status of | Client() /m_Client
server application. | the server is a reference to
The states are application the Client class in
Ready, Running, the Client DLL.
Paused, Wait, or returnval as string
Error. returnval=m_Clien
t.ApplicationStatu
s(clientID)
QueryStatus() string clientlD An interface for | String that gives | m_Client = new
out string[] status | the user to transfer the status of the | Client() //m_Client
Analyze panel operation after it | is a reference to
status messages | has been the Client class in
from the server to | performed the Client DLL.
the client On success the | returnval as string
return value is Query status
“Transferred...”. | example
GetCurrentStatelnf| string clientlD This method gets | This command m_Client = new
0o() out string the additional does not return | Client() /m_Client
WaitingMsbBxCap | information of the | any value. is a reference to
NOTE. This tion states when the | This function the Client class in
command is used | out string applicationisin | populates the Out | the Client DLL
when the WaitingMsbBxMes| Wait or Error state| parameters that | mClient.GetCurren
application is sage Except client ID, | are passed when | tStatelnfo(clientID,
running and is in | out string(] all the others are | invoking this WaitingMsbBxCap
the wait or error | WaitingMsbBxButt| Out parameters. | function. tion,
State. ontexts WaitingMsbBxMes
sage,
WaitingMsbBxButt
ontexts)

SendResponse()

NOTE. This
command is used
when the
application is
running and is in
the wait or error
state.

string clientlD

out string
WaitingMsbBxCap
tion

out string
WaitingMsbBxMes
sage

string
WaitingMsbBxRes
ponse
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After receiving the
additional
information using
the method
GetCurrentStatelnf
0(), the client can
decide which
response to send
and then send the
response to the
application using
this function. The
response should
be one of the
strings that was
received earlier as
a string array in
the
GetCurrentStatelnf
o function. The
_caption and

This command
does not return
any value.

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL
mClient.SendResp
onse(clientD,
WaitingMsbBxCap
tion,
WaitingMsbBxMes
sage,
WaitingMsbBxRes
ponse)
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Command name | Parameters Description Return value Example

_message should
match the
information
received earlier in
the
GetCurrentStatelnf
o function.

Ready: Test configured and ready to start
Running: Test running

Paused: Test paused

Wait: A popup that needs your inputs
Error: An error is occurred

out string clientlD

Name Type Direction Description

clientlD string ouT Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

out string[] status

Name Type Direction Description

status string array ouT The list of status
messages generated
during the run

out string WaitingMsbBxCaption

Name Type Direction Description

caption string out The wait state or error
state message sent to
you

out string WaitingMsbBxMessage

Name Type Direction Description

message string ouTt The wait state/error
state message sent to
you
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out string[] WaitingMsbBxButtontexts

Name Type Direction Description

buttonTexts string array ouTt An array of strings
containing the possible
response types that
you can send

string WaitingMsbBxResponse

Name Type Direction Description

response string IN A string containing the
response type that you
can select (it must be
one of the strings in the
string array
buttonTexts)

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

Query status example
returnVal=m_Client.QueryStatus(clientID, out statusMessages)
if (OP_STATUS)returnVal == OP_STATUS.SUCCESS)
return “Status updated...”

else

return CommandFailed(returnVal)
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After the test is complete

78

Command name

Parameters

Description

Return value

Example

GetPassFailStatu
s()

string clientlD
string device

This method gets
the pass or fail

String that gives
the status of the

m_Client = new
Client() //m_Client

string suite status of the operation afterit | is a reference to

string test measurement after| has been the Client class in
test completion. | performed the Client DLL.
_ |Returnsthepass |returnval as string
NOTE. Execute | or fail status in the | returnval=m_Clien
this command formof astring | t.GetPass-
after completing FailStatus(clientID,
the measurement. device,suite,
— "HF1-1- VL and

VSwing”)
GetResultsValue()| string clientID This method gets | String that gives | m_Client = new

string device

the result values of

the status of the

Client() //m_Client

string suite the measurement | operation after it | is a reference to
string test after the run. has been the Client class in
string performed the Client DLL.
parameterString Returns the result | returnval as srting
value in the form | returnval=m_Clien
of a string t.GetResultsValue(
clientlD,device,suit
e, "HF1-1- VL and
VSwing")
GetResultsValueF | string clientlD This method gets | String that gives | m_Client = new
orSubMeasureme | string device the result values | the status of the | Client() //m_Client
nts() string suite for individual sub- | operation after it | is a reference to
string test measurements | has been the Client class in
Results Panel after the run. performed the Client DLL.
Column Name Returns the result | returnval as string
int rowNr value in the form | Get results for a

of a string

submeasurement
example
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Command name | Parameters Description Return value Example

GetReportParamet string clientlD This method gets | The return value is| m_Client = new

er() string device the general report | the oscilloscope | Client() //m_Client
string suite details suchas | model, is a reference to
string test oscilloscope TekExpress the Client class in
string model, version, and HDM | the Client DLL.
parameterString | TekExpress version. returnval as string

version, and HDM
version.

Oscilloscope
Model
returnval=m_Clien
t.GetReportParam
eter(clientID,"Scop
e Model")
TekExpress
Version
returnval=m_Clien
t.GetReportParam
eter(clientID,"TekE
xpress Version")
HDM Version
returnval=m_Clien
t.GetReportParam
eter(clientID,"Appli
cation Version")
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Command name | Parameters Description Return value Example
TransferResult() | string clientlD This method String that gives | m_Client = new
string filePath transfers the the status of the | Client() /m_Client

report generated | operation afterit | is a reference to
after the run. has been the Client class in
The report performed the Client DLL.
contains the Transfers all the | returnval as string
summary of the | result values in the| returnval=m_Clien
run. formof astring | t.TransferResult(cli
The client must entID,"C:\Report”)
provide the

location where the
report is to be
saved at the client-
end.

Transferimages() | string clientlD

string filePath

This method
transfers all the
images (screen
shots) from the
specified client
and folder for the
current run (for a
suite or
measurement).

NOTE. Every time
you click Start, a
folder is created in

String that gives
the status of the
operation after it
has been
performed
Transfers all the
images in the form
of a string

m_Client = new
Client() //m_Client
is a reference to
the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.Transferimages(c
lientlD, "C:
\Waveforms”)

the X: drive.
Transfer the
waveforms before
clicking Start.
out string clientlD
Name Type Direction Description
clientlD string ouTt Identifier of the client

that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70
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string device

TekExpress programmatic interface

Name

Type

Direction

Description

device

string

IN

Specifies the name of
the device

For example "HDM
Physical Layer
Solution”

string suite

Name

Type

Direction

Description

suite

string

IN

Specifies the name of
the suite
For Example "Source";
"Sink Electrical"; "Sink
Protocol"

string test

Name

Type

Direction

Description

test

string

IN

Specifies the name of
the test to obtain the
pass or fail status.
Test Names for Source:
"HF1-1- VL and
VSwing"; "HF1-2-
TRISE, TFALL";
"HF1-3- Inter-Pair
Skew"; "HF 1-4- Intra-
Pair Skew"; "HF 1-5-
Differential Voltage";
"HF1-6- Clock Duty
Cycle and Clock Rate";
"HF1-7- Clock Jitter";
"HF1-8- Data Eye
Diagram"

int rowNr

Name

Type

Direction

Description

rowNr

int

IN

Specifies the zero
based row index of the
sub-measurement for
obtaining the result
value
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NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

string parameterString

Name Type Direction Description

parameterString string IN Specifies the
oscilloscope model,
TekExpress version,
and HDM version

string filePath

Name Type Direction Description

filePath string IN The location where the
report must be saved in
the client

NOTE. If the client does not provide the location to save the report, the report is
saved at C:\ProgramkFiles.

Get results for a submeasurement example

This example returns the specified submeasurement results for test HF1-2-
TRISE, TFALL.

returnval=m_Client.GetResultsValue( clientID," "HDM Physical Layer
Solution", "Source", "HF1-2- TRISE, TFALL","Value",0)

returnval=m_Client.GetResultsValue( clientID," "HDM Physical Layer
Solution", "Source", "HF1-2- TRISE, TFALL","Value",1)
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Save recall or query a

saved session

TekExpress programmatic interface

Command name | Parameters Description Return value Example
CheckSessionSav | string clientlD This method Return valueis | m_Client = new
ed() out bool saved checks whether | either True or Client() //m_Client
the current False is a reference to
session is saved. the Client class in
the Client DLL.
returnval as string
returnval=m_Clien
t.CheckSessionSa
ved(m_clientID,
out savedStatus)
RecallSession() | string clientlD Recalls a saved | String that gives | m_Client = new

string name

session. The client
provides the

the status of the
operation after it

Client() //m_Client
is a reference to

session name. has been the Client class in
performed the Client DLL.
The return value is| returnval as string
“Session returnval=m_Clien
Recalled...” t.RecallSession(cli
entlD,
savedSessionNam
e)
SaveSession() string clientlD Saves the current | String that gives | m_Client = new
string name session. The client| the status of the | Client() //m_Client
provides the operation after it | is a reference to
session name. has been the Client class in
performed the Client DLL.
The return value is| returnval as string
"Session returnval=m_Clien
Saved..."/"Failed...| t.SaveSession(clie
" ntiD,
desiredSessionNa
me)
SaveSessionAs() | string clientID Saves the current | String that gives | m_Client = new
string name session undera | the status of the | Client() /m_Client
different name operation after it | is a reference to
every time this has been the Client class in
method is called. | performed the Client DLL.
The client provides| The return value is| returnval as string
the session name. | "Session Saved..."| returnval=m_Clien
t.SaveSessionAs(c
lientID,
desiredSessionNa
me)
string name
Name Type Direction Description
name string IN The name of the
session being recalled

TekExpress HDM Advanced Analysis and Compliance Solution

&3



TekExpress programmatic interface

The name parameter cannot be empty. If it is empty, the client is prompted to
provide a valid name.

out bool saved

Name Type Direction Description

saved bool ouTt Boolean representing
whether the current

session is saved

This parameter is used as a check in SaveSession() and SaveSessionAs()
functions.

out string clientlD

Name Type Direction Description

clientlD string ouT Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Unlock the server Command name | Parameters Description Return value Example

UnlockSession() | string clientID This method String that gives | m_Client = new
unlocks the server | the status of the | Client() //m_Client
from the client. operation after it | is a reference to

The ID of the client has been the Client class in
to be unlocked performed the Client DLL.
must be provided. | The return value is| returnval as string
Note "Session Un- returnval=m_Clien
Locked..." t.UnlockServer(clie
ntID)
out string clientlD
Name Type Direction Description
clientlD string ouT Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, the client is unlocked automatically.

NOTE. The Fail condition for this command occurs in the following conditions:

If the server is LOCKED the command returns "Server is locked by another
client”.

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".

TekExpress HDM Advanced Analysis and Compliance Solution 85




TekExpress programmatic interface

Disconnect from the Command name | Parameters Description Return value Example

server Disconnect() string clientlD This method Integer value that | m_Client = new
disconnects the | gives the status of | Client() //m_Client
client from the the operation after | is a reference to
server. Note it has been the Client class in
performed the Client DLL.

1 for Success returnval as string
—1 for Failure returnval=m_Clien
t.Disconnect(m_cli
entID)

out string clientlD

Name Type Direction Description

clientlD string ouT Identifier of the client
that is connected to the
server

clientID = unique
number + ipaddress of
the client. For example,
1065-192.157.98.70

NOTE. When the client is disconnected, it is unlocked from the server and then
disconnected. The id is reused.

NOTE. The Fail condition for this command occurs in the following conditions:
If the server is LOCKED the command returns "Server is locked by another
client".

If the session is UNLOCKED the command returns "Lock Session to execute the
command".

If the server is NOTFOUND the command returns "Server not
found...Disconnect!".

If none of these fail conditions occur the command returns "Failed...".
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Algorithms

About algorithms

For all measurements, use the following guidelines to set up the oscilloscope.

Oscilloscope Setup  The following guidelines are generalized.

Guidelines . .
The signal is any channel, reference, or math waveform.

m  The vertical scale for the waveform must be set so that the waveform does
not exceed the vertical range of the oscilloscope.

m  The sample rate must be set to capture sufficient waveform detail and avoid
aliasing.

m  Longer record lengths increase measurement accuracy but the oscilloscope
takes longer to measure each waveform.
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HDM Source tests

HF1- 2 - Source TMDS Electrical - 6G -Trisg, TraLL

This test confirms that the rise times and fall times on the TMDS differential
signals fall within the limits of the specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

m  Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.

Differential measurement

Power supply

103.30

\§J " CLOCKN
:\CLOCKJ
EDID emulator / EDID PCB __ DATA2_P
[— _ DATA2N
DATA1_P
DATA1_N
 DATAOP L
 DATAOLN H |
 CLOCK.P
 CLOCKN

(== HPD
<1 HPD

i

Pull up
p

:

-

=4

=
=

=

Source DUT

10J08UU07) INAH

Notes:

Connect to biased 502 termination such as input port of unoccupied differential SMA probes.

Set the DUT to operate in normal mode.
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Measurement algorithm

The algorithm calculates the rise and fall time of the waveform as per the
following steps:

1.
2.

Given a waveform, find the Vg and Vi gy
Measure Vi ow

a. Capture 1000 or more repetitions, triggered at the vertical mid-point of
the High-to-Low transition of a H-L-L-L bit sequence. Each capture must
be of duration 3 times TBIT.

b. Display the voltage (vertical) histogram on the scope, with the histogram
data accumulated only from the last 2-bits of the H-L-L-L sequence.

c. Read the V[, value as the most common low-level (mode) voltage
shown on the histogram.

Measure Vg

a. Capture 1000 or more repetitions, triggered at the vertical mid-point of
the High-to-Low transition of a L-H-H-H bit sequence. Each capture
must be of duration 3 times TBIT.

b. Display the voltage (vertical) histogram on the scope, with the histogram
data accumulated only from the last 2-bits of the L-H-H-H sequence.

¢. Read the Vyjgp, value as the most common low-level (mode) voltage
shown on the histogram.

Measure Tgisg as the mode of the sampled edge times from 20% to 80% of
the differential swing voltage (Vyign) rising edge.

Measure Tgap 1 as the mode of the sampled edge times from 80% to 20% of
the differential swing voltage (V| ) on the falling edge.

HF1- 3 - Source TMDS Electrical - 6G - Inter-Pair Skew

This test confirms that the skew between two data lanes on the TMDS differential
signals fall within the limits of the specification.

90

Required test equipment

In addition to the DUT, you will need the following:

Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

Four Differential probes — P7313SMA, for single ended and differential tests
Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Differential measurement

Power supply

W | ~SCLOCKN

:a\CLOCKfP

DATA2 P
EDIDemglaiorIED\D PCB o g -Pull m
=@ —-DATAZ_N ( Pullup )
DATA1_P
I __ DATA1N
o o | £ Pull up
2 | ., DATAO.P a9y
Source DUT § ___ DATAD_N |
2 . _ CLOCK_P
E —
CLOCK_N
01— HPD
<171 HPD
Notes: Pull up

Connect to biased 502 termination such as input port of unoccupied differential SMA probes.

HDM Source tests

The algorithm calculates the skew between the differential pairs in the TMDS
portion as per the below steps. Inter pair skew test is a differential test and is only
for data signals. Clock signal is excluded for this test, but is used for calculating
the Thit.

1. Connect and acquire the Data 0 and Data 1 signals.

2. Set the Digital Oscilloscope horizontal setting: sampling rate >= 25 Gs/sec
and Record Length set to 100 M.

Decode the bit stream of Data 0 and Data 1.

4. Search for the 20 bit unscrambled control code (SSCP) on Data 0 and Data 1.
SSCP might have one of the following 10 bit values:

Stop acquisition and measure TSKEW between channels.

1101010100
0010101011
0101010100
1010101011

6. Repeat the test for the remaining combinations of TMDS DATAX pairs.
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HF1- 6 - Source TMDS Electrical - 6G - Clock Duty Cycle and Clock Rate

This test confirms that the duty cycle and clock rate of the TMDS differential
clock complies with the limits mentioned in specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for Single Ended and Differential
tests

m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

m  Power supply: PWS4205 or PWS2185 (if using external Power Supply
option)

Connect the equipment as shown in the Source differential diagram.

Differential measurement

Power supply
,_‘\CLOCK_N
CLOCK_P
EDID emulator / EDID PCB DATA2_P
;. ] — Pull up
., DATA2 N
‘,:, o DAALP o
T ! ] —”DATALN Pull up
£ L ___DATAD_P L
Source DUT § ~___ DATAON au
g | ) __ CLOCKP
(=] -
- _ CLOCKN
(= HPD
<11 HPD
Notes: Pull up

Connect to biased 502 termination such as input port of unoccupied differential SMA probes.

Set the DUT to operate in normal mode.
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Measurement algorithm  The algorithm calculates the Clock Duty Cycle of the waveform as per the
following steps:

1. DPOJET measurement is used to perform this test.

2. The Duty Cycle (Max) and Duty Cycle (Min) measurements calculate the
difference in positive (or negative) pulse widths from one cycle to the next.

3. The application calculates these measurements using the following equations:

AW =AW —AW’

AW =AW —AW.

Where:

m AW+ is the difference between positive pulse widths of adjacent clock
cycles.

m  AW-is the difference between negative pulse widths of adjacent clock
cycles.

m W+ is the positive pulse width measurement.

m  W-is the negative pulse width measurement.

HF1- 7- Source TMDS Electrical - 6G - Clock jitter

This test confirms that the clock jitter of the TMDS differential clock complies
with the limits mentioned in specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.
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Measurement algorithm

Differential measurement

Power supply

_‘\CLOCK_N
CLOCK_P
DATA2 P
EDIDemgI.aior_f EDID PCB o 8 -Pull m
] —-DATAZ_N ( Pullup )
DATA1_P
i)
‘I _ DATALN
o o | Pull up
= B ., DATAO.P a9y
Source DUT § ___ DATAD_N |
2 __ CLOCK_P
E L
___ CLOCK_N
01— HPD
<71 HPD
Notes: Pull up

Connect to biased 502 termination such as input port of unoccupied differential SMA probes.

Set the DUT to operate in normal mode.

TekExpress HDM automatically executes the following calculations:

1. Acquire differential clock signal with same settings as before: Compliance
Mode: 50 GS/sec Compliance Mode: 18M.

2. Apply 12.5x BW enhancement filter and save the wfm: - C:\TekScope\Math
Arbitrary Filters\Probe-Filters\P7313 SMA 12.5x 16GHz 50GSs.flt and
save this wfm as Clk. BWE.wfm.

Pass Clk. BWE.wfm from step 2 to algorithm for swing calculation.
4. Swing limits: If (Vs > 1200 mV) OR (Vs <400 mV) then FAIL.

Apply Cable effect on Clk. BWE.wfm from step 2, that is apply
sdlaTp2clk.flt filter. Save this wfm as Clock CableEffect.wfm.

= Recall Clk BWE.wfm on Refl

m  Load Arbfiltl = sdlaTp2clk.flt

= Mathl = Arbfiltl(Refl)

= Save Mathl as Clock CableEffect.wfm
6. Recall Clock CableEffect.wfm on Refl

Load load arbfilt] = HDMI2 EQ 50G.flt
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Mathl = arbfilt1(Refl)

9. Pass Mathl from step 8 to DPOJET for jitter calculation. DPOJET settings
are same as before:

Edge->Rising->50% TIE CH1

Signal Type: Clock

Clock Edge: Rise

Clock Recovery => Method: PLL Custom BW
PLL Model: Type I

Loop BW :4 MHz

Filter Spec : I st Order

Freq (F1) : 4 MHz

10. If Clock jitter exceeds 0.3 times TBIT then FAIL.

HF1- 8 - Source TMDS Electrical - 6G - Data Eye Diagram

This test confirms that the HDMI Data output has signal quality that meets the
eye opening required by the specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests

m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

= Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source data eye diagram.
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Data eye diagram measurement

Power supply

Power supply

[03.30

: NELOCK_N

CLOCK_P

EDID emulator / EDID PCB _ DATAZP
== DATAZ N

ﬁé

Pull up

DATA1_P
—_DATAMI_N

i

Pull up

Pull up

ﬁ

___ DATAOP >

B | ___DATAON p o

7

Source DUT

10}98UL07) |WAH

_ CLOCKP
_ CLOCKN

17— HPD

O— HPD

Notes:

Connect to biased 50¢ termination such as input port of unoccupied differential SMA probes. wona0

Set the DUT to operate in normal mode.

Measurement algorithm  TekExpress HDM automatically executes the following calculations:
This is a DPOJET based measurement.
CTS Procedure
= Source Eye Diagram test is measured at TP2_ EQ.
m  TP2 is the signal after passing along a worst cable.

= Worst cable has worst attenuation and skew of 112 ps.
Measurement procedure

1. Connect Clock of the HDMI 2.0 source DUT to Chl of the oscilloscope.
(Adding Type 4 Cable Emulator and inserting 112 ps delay on all TMDS data
positive lanes.)

2. Connect Data0 (0/1/2/) +ve of the HDMI 2.0 Source to Ch3 of the
oscilloscope.

3. Connect Data0 (0/1/2/) -ve of the HDMI 2.0 Source to Ch4 of the
oscilloscope.
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4. On Clock signal :
m  Load Arbfiltl = sdlaTp3DIFFSrc1.flt — sdlaTp2clk.flt
= Mathl = Arbfiltl (Chl)
m  Save Math1 as 1-7 TMDS Data Eye Diagram Clock.wfm
5. On Data signal, load below filter files:
m  ArbFiltl = sdlaTp2ADp.flt
= ArbFilt2 = sdlaTp2ADn.flt
= ArbFilt3 = sdlaTp2BDp.flt
m  Arbfilt4 = sdlaTp2BDn.flt
6. Define Math waveforms
m  Math2 = Arbfiltl (Ch3) + Arbfilt2 (Ch4)
m  Math3 = ArbFilt3 (Ch3) + Arbfilt4 (Ch4)

= Save Math4 = Math 2 — Math3 as 1-7 TMDS Data Eye
Diagram Data.wfm

Clear all Maths and filter file definitions.

Recall 1-7 TMDS Data Eye Diagram_Clock.wfm on Refl.
9. Recall 1-7 TMDS Data Eye Diagram Data.wfm on Ref2.
10. Load arbfilt] = HDMI2 EQ 50G-lt.

Mathl = arbfiltl (Refl)

Math2 = arbfiltl (Ref2)
11. Perform DPOJET ->Mask Hits measurements with below settings:

m  Clock Recovery == Method: Explicit Clock — PLL,

= Clock Source: Mathl

= Clock Edge: Rise

m  Clock Multiplier: 40

m  PLL Model: Type ]

®  Damping: 700 m

= Loop BW:4 MHz

m  Mask File = Data Rate 5.92 Gbps.msk

m  Clock offset = Auto

m  BitType = All

m  Plot = Eye Diagram
12. Perform DPOJET ->Eye width measurements with below settings:

m  Clock Recovery => Method: Explicit Clock — PLL,

= Clock Source: Mathl

= Clock Edge: Rise
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= Clock Multiplier: 40

= PLL Model: Type |

®  Damping: 700 m

= Loop BW:4 MHz

m  Clock offset = Auto

= Bit Type = All

m  Measurement setting ->Cursor gating ON

13. Enable the measurement with vertical cursors on at 5% and 95% of the
oscilloscope acquisition.

14. Perform the above measurement on Datal and Data2 by repeating the steps
from (2) to (13).

(Adding Type4 Cable Emulator and inserting 112 psec delay on all TMDS data
negative lanes.)

1. Connect Clock of the HDMI 2.0 source DUT to Chl of the oscilloscope.

2. Connect Data0 (0/1/2/) +ve of the HDMI 2.0 Source to Ch3 of the
oscilloscope.

3. Connect Data0 (0/1/2/) -ve of the HDMI 2.0 Source to Ch4 of the
oscilloscope.

4. On Clock signal:
m  Load Arbfiltl = sdlaTp3DIFFSrcl.flt — sdlaTp2clk.flt
= Mathl = Arbfiltl (Chl)
m  Save Mathl as 1-7 TMDS Data Eye Diagram Clock.wfm
5. On Data signal, load these filter files:
= ArbFIlt] = sdlaTp2 ADp.flt
m  ArbFilt2 = sdlaTp2ADn.flt
m  Arbfilt3 = sdlaTp2BDp.flt
®m  Arbfilt4 = sdlaTp2BDn.flt
6. Define Math waveforms:
®m  Math2 = Arbfilt]l (Ch4) + Arbfilt2 (Ch3)
= Math3 = ArbFilt3 (Ch4) + Arbfilt4 (Ch3)

= Save Math4 = Math 3 — Math2 as 1-7 TMDS Data Eye
Diagram Data.wfm

7. Clear all Maths and filter file definitions.

Recall 1-7 TMDS Data Eye Diagram_Clock.wfm on Refl
9. Recall 1-7 TMDS Data Eye Diagram_Data.wfm on Ref2
10. Load arbfiltl = HDMI2 _EQ_50G.flt

Mathl = arbfiltl(Ref1)

Math2 = arbfiltl(Ref2).
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11. Perform DPOJET ->Auto Fit Mask Hits with below settings:

12.

13.

Clock Recovery => Method: Explicit Clock — PLL,
Clock Source: Math1

Clock Edge: Rise

Clock Multiplier: 40

PLL Model: Type I

Damping: 700 m

Loop BW: 4 MHz

Mask File = Data Rate 5.92 Gbps.msk
Clock offset = Auto

BitType = All

Plot = Eye Diagram

Perform DPOJET ->Eye width measurements with below settings:

Clock Recovery => Method: Explicit Clock — PLL,
Clock Source: Mathl

Clock Edge: Rise

Clock Multiplier: 40

PLL Model: Type I

Damping: 700 m

Loop BW: 4 MHz

Clock offset = Auto

Bit Type = All

Measurement setting ->Cursor gating ON

Enable the measurement with vertical cursors on at 5% and 95% of the scope
acquisition. Perform the above measurement on Data 1 and Data 2 by
repeating the steps from (2) to (13). Repeat the test for remaining supported
test character rates. Only one video format/pixel-size combination is required

per TMDS character rate.

TP2 mask

Table 17: Mask coordinates at different data rates

TMDS Bit Rate (Gbps) H (Tbit) V (mV)
3.71 0.6 335
446 0.56 295
5.94 0.4 150
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HDM Data Eye Diagram  When performing the HDM Data Eye Diagram test (Source), if the test fails due

Test - Mask Movement  to mask hits, you are presented with a dialog box to enter a timing value that will
be used to shift the Mask horizontally, thus allowing the test to pass. You will
have up to three opportunities to adjust the mask position. If, after three attempts,
the test still fails due to any mask hits, the test will stop and report the test as
failed. The first message you see when the Eye Diagram test fails due to mask
hits provides a short description of what you need to adjust the mask position.

After you select OK, the Measure the Deskew Value dialog box displays. Once
you determine the amount of time (in picoseconds) to shift the mask horizontally,
enter the value here.

Measure the Deskgw Value
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HF1-1- Source TMDS Electrical - 6G -V and Vgying

This test confirms that the low voltage level of the TMDS single-ended signals
and the Swing of the single-ended signals complies with the limits listed in the
specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

m  Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source single ended diagram.

Single ended measurement

Power supply o

\CLOCK_P
EDID emulator / EDID PCB ., DATA2 P
‘ ., DATA2 N
GE ., DATALP <)
z -, DATATN Pl
= Wl . DATA0_P
g r T ATAOLN 2
Source DUT % | i i
2 _ CLOCK_P
=2 ] T —eeeeeeee |
1 CLOCK N
.7 HPD
T HPD
Notes: Pull up

Connect to biased 50€2 termination such as input port of unoccupied differential SMA probes.

Set the DUT to operate in normal mode.
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Measurement algorithm

The algorithm calculates the rise and fall time of the waveform as per the
following steps:

Given a waveform, find the Vg and Vi oy

1.

Measure Vi gw:

a. Capture 1000 or more repetitions, triggered at the vertical mid-point of
the High-to-Low transition of a H-L-L-L bit sequence. Each capture must
be of duration 3 times TBIT.

b. Display the voltage (vertical) histogram on the scope, with the histogram
data accumulated only from the last 2-bits of the H-L-L-L sequence.

c. Read the Vi, value as the most common low-level (mode) voltage
shown on the histogram

d. Capture 1,000 or more repetitions, triggered at the vertical mid-point of
the Low-to-High transition of a L-H-H-H bit sequence. Each capture
should be of duration 3 times Tbit.

e. Display the voltage (vertical) histogram on the oscilloscope, with the
histogram data accumulated only from the last 2-bits of the L-H-H-H
sequence.

f. Read the Vy;g, value as the most common high-level voltage shown on
the histogram.

g. Calculate Vgying = Vigh — Viow-

In the case of Data Signals:

B If (Vigw <230 V)or (290 V<V, ), then FAIL.

5 If (Vsying <400 mV) or (600 mV < Vgy;ip,), then FAIL.
In the case of Clock Signals:

B If (VL ow <2.30 V) or (3.10 V < V[ o), then FAIL.

5 If (Vsying <200 mV) or (600 mV < Vgyo), then FAIL.
Repeat the test for all eight TMDS signals.

HF1- 4 - Source TMDS Electrical - 6G - Intra-Pair Skew

This test confirms that the skew between the positive and negative lane of the
TMDS single ended signals complies with the limits mentioned in specification.

Required test equipment
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In addition to the DUT, you will need the following:

Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

Four Differential probes — P7313SMA, for single ended and differential tests)
Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source single ended diagram.
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Measurement algorithm

Set the DUT to operate in normal mode.

Single ended measurement

@

Power supply

|

gy |l

E\ CLOCK_P

EDID emulator / EDID PCB

I

|

Source DUT

10198UU0Y) NAH

—_—

7

T DATA2_P
T DATA2_N
- DAL P Pull up
— DATA1_N

DATAO_P

i

Pull up

1

o
5
>
=]
=
'i
=
=
=l

=B = Pull up
T CLOCK_P

Notes:

T CLOCK_N

17— HPD

[T HPD

Connect to biased 50€2 termination such as input port of unoccupied differential SMA probes.

HDM Source tests

TekExpress HDM automatically executes the following described calculations

described:

The algorithm calculates the skew within any Differential pair in the TMDS
portion as per below steps. Intra-pair skew test is a single-ended measurement.

1. Capture DO+, DO- single-ended signals.

2. Search for at least 1000 occurrences of HLLL pattern on DO+ and LLLH on
DO-. Capture these as qualified region for the measurement.

3. Measure the average skew between the corresponding rising edges of DO+
and falling edges of DO- of the qualified region.

4. Repeat the test for all remaining TMDS differential pairs.
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HF1- 5 - Source TMDS Electrical - 6G - Differential Voltage

This test confirms that the voltage level of the TMDS differential signals
complies with the limits in the specification.

Required test equipment  In addition to the DUT, you will need the following:

m  Digital Storage Oscilloscope: DPO/DSA/MSO Series Oscilloscope with BW
greater than or equal to 16 GHz

m  Four Differential probes — P7313SMA, for single ended and differential tests
m  Test fixture: TF-HDM-TPA-S fixture for Source to be used for source testing

m  Power supply: PWS4205 or PWS2185 (if using external power supply
option)

Connect the equipment as shown in the Source differential diagram.

Differential measurement

Power supply

03.30]

"'-:'ng.»\CLOCK_N
\CLOCKJ
EDID emulator / EDID PCB DATAZ_P
;. ] — Pull up
., DATA2 N Rt
‘,:, -, DATA1P T
[ CPullup )
= | ] —”DATALN Pull up
2 L _‘ _ DATAOP L
Source DUT § __ DATAON sl
e | ) _ CLOCKP
=] S
- _ CLOCKN
(= HPD
<71 HPD
Notes: Pull up

Connect to biased 50€ termination such as input port of unoccupied differential SMA probes.

Set the DUT to operate in normal mode.
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Measurement algorithm  The algorithm calculates the Differential voltage on Differential TMDS lanes
clock, D0, D1, D2 as per following steps:

Given a waveform, find the Maximum Differential Voltage and Minimum
Differential Voltage.

Measure Minimum Differential Voltage:

1. Capture 1000 or more repetitions, triggered at the vertical mid-point of the
High-to-Low transition of a H-L-L-L bit sequence. Each capture must be of
duration 3 times TBIT.

2. Display the voltage (vertical) histogram on the scope, with the histogram data
accumulated only from the last 2-bits of the H-L-L-L sequence.

3. Read the Minimum Differential Voltage value as the most common low-level
(mode) voltage shown on the histogram.

Measure Maximum Differential Voltage:

1. Capture 1000 or more repetitions, triggered at the vertical mid-point of the
High-to-Low transition of a L-H-H-H bit sequence. Each capture must be of
duration 3 times TBIT.

2. Display the voltage (vertical) histogram on the scope, with the histogram data
accumulated only from the last 2-bits of the L-H-H-H sequence.

3. Read the Maximum Differential Voltage value as the most common low-
level (mode) voltage shown on the histogram.
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HDM - Sink Electrical tests

HF2-1 Min-Max Differential Swing Tolerance

This HDMI Receiver test confirms that the Sink properly supports TMDS
differential voltages at minimum and maximum levels.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal Generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and Option SDX with Direct
Synthesis capability to simulate Cable emulator effect and Rise time filter
effect.

m  Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test fixture: One set of TF-HDM-TPA-S fixture

= DC Power Supply: Tektronix Power Supply or any other

m  Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
®  Audio/Video Display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1. Connect the equipment as shown in the Sink Min diagram for AWG7122C or
Sink Min diagram for AWG70002A.
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Sink Min diagram for AWG7122C

AFG w Ext Ref In

AWGT122C (Slave)

AWGT7122C (xowzwom(wm«l
i)

CLK—_ Marker D1 | [Marker D2
output

output

RA Y Bas Bias T, hAK
‘ —‘ W voltage voltage 1 [
i D1”W | [ o2 .
‘—Lr‘,_ll
P | Lol |
ower supply e ‘ gy
Y L
o /
I~ Second row of
: connectors below
\_ CLK
Sink Min diagram for AWG70002A
AFG WEM RefIn
| © | AWGT0002A (Slave)
[ Exl Clock In Tol::l -
o (TriginA TrignA 8800
| 0 ECE T T Ty
D1 D2 Marker
output

2

120ps TTC Filter |_ :
- A { J— L
YYYY Bias DPO/DSA/MSO 70000 Series B
[ [ L voltage voltage |
.4 o _
Power supply
"
1 econd row of
i ; _ connectars below
. oK
\. e -

2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings.

a. Frequency: Highest frequency supported by the Sink DUT
b. Pattern: HDMI Gray Ramp data streams

108 TekExpress HDM Advanced Analysis and Compliance Solution



HDM - Sink Electrical tests

c. Rise/fall times:
Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.

d. Set the common mode voltage (VICM) to 3.1 V.

e. Set the differential swing voltage to 150 mV. Confirm the Sink DUT
support. If the Sink DUT does not support the transmitted resolution,
then FAIL: “Min diff swing unsupported at VICM1 range”.

f. Change VICM to 3.3 V. Confirm that the Sink DUT continues to support
the transmitted image without errors. If the Sink DUT does not support
the transmitted resolution, then FAIL: “Min diff swing unsupported at
VICM2 range”.
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g. Connect the equipment as shown in the Sink Max diagram for
AWGT7122C or Sink Max diagram for AWG70002A.

Sink Max diagram for AWG7122C

AFG w Ext Ref In

AWGT7122C (xowmelomm\amerl
i)

AWGT122C (Slave)

===l

Trig In A
CLK." Marker Do o L = DT- Marker 02
output output
[Te eo®) @ ‘ T,
o . i |

y » DPO/DSA/MSO 70000 Series oy Y
T - Bias Bias - mm

‘ —‘ W voltage voltage

D1

Power supply

\\

Second row of
connectors beiow

1
-
|
§

2|

VR

Sink Max diagram for AWG70002A

AFG wExt RefIn

Ext Clock In
TriginA |
i}
|

AWGT0002A

10 MHz Ref Out (Master)

o) ®|

2

i

Marker
output
; DPO/DSAIMSO 70000 Series
Bias Bias [
voltage voltage ‘
Y of
Power stipply
s -
\ CLK

-

Note: For AWG7122C, the connection remains the same as the nominal

pattern.

TekExpress HDM Advanced Analysis and Compliance Solution



HF2-2 Intra-Pair skew test

HDM - Sink Electrical tests

h. Set the common mode voltage (VICM) to 2.6 V.

i. Change the differential voltage to 1200 mV (600 mV/single-ended signal
= max swing).

j. Verify that the Sink DUT continues to support the transmitted image
without errors.

k. Ifthe Sink DUT does not support the transmitted image, then FAIL:
“Max diff swing unsupported at VICM1 range”.

I. Change VICM to 3.3 V. Verify that the Sink DUT continues to support
the transmitted image without errors.

m. Ifthe Sink DUT fails to support the transmitted image, then FAIL: “Max
diff swing unsupported at VICM?2 range”.

This HDMI Receiver test confirms that the maximum allowed timing skew
within each TMDS pair is supported by the Sink DUT.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal Generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and Option SDX with Direct
Synthesis capability to simulate Cable emulator effect and Rise time filter
effect.

Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test Fixture: One set of TF-HDM-TPA-S fixture

DC Power Supply: Tektronix Power Supply or any other

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
Audio/Video Display

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1.

Connect the equipment as shown in the Sink Intra-pair skew diagram for
AWG7122C or Sink Intra-pair skew diagram for AWG70002A.
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Sink Intra-pair skew diagram for AWG7122C

AFG w Ext Ref In

AWGT7122C (xowmelomm\amerl

' % % AWGT122C (Save)
| em—] o g
Trig In A
CLKv—' Marker Do - A DT- Marker D2
output output
——\ — |
RA Y Bas Bias T, hAK
‘ —‘ W voltage voltage 1 [
D1 .
Power supply -
\\
s : connectors below
\_ CLK % |
o A "

f9 e e el ANGTH002A (Slave)
l[ Ext Clock In |O8s" -

Trig InA

E-E-X-N
(7] O o000
CLK D0 | Marker D1 D2 Marker
output output
B
120ps TTC Filter
L By
y DPO/DSA/MSO 70000 Series
LARR Bias Bias L ‘3‘
[ [ L voltage voltage{ \L
Y D1 D2 —
Power supply
o Iy
~ Second row of
i ; _ connectars below
\ oK Py
R
. P s

2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings.

a. Frequency: Highest frequency supported by the Sink DUT
b. Pattern: HDMI Gray Ramp data streams
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d.

c.

HDM - Sink Electrical tests

Rise/fall times:

Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.
Set VICM to 2.8 V.

Set Single Ended Swing to 500 mV.

3. Do the following for each TMDS differential pair Clock and Data:

a.

HF2-3-Jitter Tolerance test

This HDMI Receiver test confirms that the maximum allowed clock jitter on
TMDS signal is supported by the Sink DUT.

Apply worst skew at TP2 to the pair being tested:
Set skew of .15*Tbit on one line against the other line.

Apply the Worst Cable Emulator after the TMDS Signal Generator to
cause 112 ps signal delay on the line of the TMDS differential pair
against the other line.

Enable Scrambling mode on DUT.
Operate the TMDS Signal Generator to output the tested Video Format.

If the Sink DUT fails to adequately support the transmitted image, then
FAIL.

Switch the setting of the signal delay on the other line for the tested
TMDS differential pair.

If the Sink DUT fails to adequately support the transmitted image, then
FAIL

Repeat the test for the remaining untested pairs.
For all TMDS signals, set (VICM) to 3.3 V and repeat the procedure.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal Generator: Two AWG70002A with options 01, 03 and 225, or
two AWG7122C with options 1, 2/6, 8, and Option SDX with Direct
Synthesis capability to simulate Cable emulator effect and Rise time filter
effect.

Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test Fixture: One set of TF-HDM-TPA-S fixture

DC Power Supply: Tektronix Power Supply or any other
Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
Audio/ Video Display
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Measurement algorithm
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The following procedure is fully automated by Tektronix HDM Compliance

Software (Option HDM-DS ):

1. Connect the equipment as shown in the Sink Jitter tolerance diagram for
AWG7122C or Sink Jitter tolerance diagram for AWG70002A.

Sink Jitter tolerance diagram for AWG7122C

AFG w Ext Ref In

|
AWGT122C (‘.o MHz Ref Oul (Master] 1
[ | = L IeIE

l l Ext Clock In

AWGT122C (Slave)

f: Trig In A Trig In A ) o ;
CK | Marker | | PO o [)1 Merker | | o o
output output |
|
o |
‘ 5. |
" T e e 1 i L] ‘ n
T\ j t /1 | ;
A ---L Bias DPQ/DSA/MSO 70000 Series Bl AA Yy
| —‘ voltage voltage —|
4 D1 & J—
Po\‘Nersupply L ki —
\. Do L
o ~ ]
R 40 |~ Second row of
)  connectors below
\_ CLK
e
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Sink Jitter tolerance diagram for AWG70002A

AFG WEn Ref In

AWGT0002A 10 MHz Ref Out (Master) E P g @ ¢ AWGT70002A (Stave)
A l Ext Clock In i 00 [

oo |TiginA TriginA £.8.2.9
BEHHEF oeoo 2 | AEGEGE ecoo
CLK : DO | Marker S = o bz Markst
| output = g
|
Yy )
120ps TTC Filter J' > pool B & ]
| J L m
I" i‘ :‘ s DPO/DSA/MSQ 70000 Series Bias [ Yy 3‘
[| || voltage voliage | ‘
N D1 D2 —
Power supply r MY
b |
s
\k

2. Calibrate the HDM Signal Generator AWG7K/70K output for the following
settings.

Frequency: Highest frequency supported by the Sink DUT
Pattern: HDMI Gray Ramp data streams
c. Rise/fall times:
Set the rise/fall time of the TMDS CLOCK to between 75 ps and 110 ps.
Set the rise/fall time of the TMDS DATA between 42.5 ps and 65 ps.
d. SetVICMto29V.
e. Set Single Ended Swing to 400 mV.
f. Below are the jitter frequencies inserted on the signal:
D _JITTER =500 kHz (on TMDS_CLOCK), C_JITTER = 10 MHz.
D _JITTER = 1 MHz (on TMDS_CLOCK), C_JITTER =7 MHz.

NOTE. All jitter amounts described below are relative to a recovered
clock as measured with a Clock Recovery Unit).All four jitter frequencies
define sinusoidal jitter). [Make TP2 worst condition]

g. Apply the Worst Cable Emulator under the condition that the Worst
Cable Emulator causes delay on all TMDS DATA positive (+) lines
against negative (—) lines.

h. Generate TP2 signal and adjust the jitter amplitude as follows:

C _JITTER to be 0.3*Tbit at TP2 after processing with the CRU and
applying the Reference Cable Equalizer for 3.4 Gbps—6 Gbps.
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Data waveform (eye diagram) to nearly touch the 2 corners (right and
left) points of the TP2 EQ eye mask, but without causing a TP2_EQ eye
mask violation after processing with the CRU and applying the
Reference Cable Equalizer for 3.4 Gbps—6 Gbps.

i. Connect the TMDS Signal Generator to the Sink DUT.

a. Use the [2C Analyzer to write 1 to the Scrambling Enable bit of the
Sink DUT.

b. Operate the TMDS Signal Generator to output the tested Video
Format.

¢. Ifthe CDF field Sink Error Counter is “Y” and the DUT passed all
tests in Section 8.2.3 (Test ID HF2-18, HF2-19, HF2-20), then
measure the error rate using the Error Counter. If the Error rate is
more than 10-9, then FAIL.
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HF2-6 Sink Video Timing - 6G - 2160p 24 bit Color Depth

This test confirms that the Sink DUT supports 24-bit color depth 2160p video
format for TMDS Character rate above 340 Mcsc up to 600 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8, and Option SDX with Direct
Synthesis capability to simulate Cable emulator effect and Rise time filter
effect.

m  Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test Fixture: One set of TF-HDM-TPA-S fixture

= DC Power Supply: Tektronix Power Supply or any other

m  Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
®  Audio/Video Display

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C

AWGT7122C [ﬂ MHz Ref Out (Master)

AFG \ ExtRef In

AWGT7122C (Slave)

0

l Ext Clock In -
Trig InA Trig In A e

=y q o0 06 o0 ® 80Hx| 60 30 ¢-0 7 60 00 00 8 B0E=
T T
Marker [CLK D0 Marker | D1 D2
output output
AN
Yy DPO/DSA/MSQ 70000 Series -
o Bias Bias
T ‘[ voltage voltage | |
|1 }
| |
L | |
Power supply : |
[ 7] out
|
|
i
\_ |
N
Second row of
|_ connectors below
>

Sink Protocol diagram for AWG70002A

AFG w Ext Ref In

=

AWGT0002A 10 MHz Ref Out (Master) > ® 0 | AWGT0002A (Slave)
O [ Ext Clock In o © =
o TriglnA | Soee
@ ® W) J | T EY
CLK D1 D2 Marker
output
T
YYVYY Bias DPO/DSA/MSO 70000 Series " YV
] ias T
(] (111
Y o[ [T ]2 —
Power supply

ul /Secondmwnr

_ connectors below

2. Select the required video formats supported by the sink.
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Perform the following test for each of the video formats listed in the EDID:

a. In the case of 60 Hz formats, the TMDS Clock frequency minimum and
maximum values are +0.5%/-0.6% of 148.5 MHz.

b. In the case of 50Hz formats, the TMDS Clock frequency minimum and
maximum values are +0.5%/-0.5% of 148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

Output each one of the video format timing listed in step 3, at a minimum
allowable TMDS clock frequency and maximum allowable TDMS clock
frequency. Perform steps 3 through 6 for each frequency.

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
26V.

Recall the pattern on the AWG, synchronize the master and the slave AWGS.
Verity the Display is working, if not the result is FAIL.

a. If the Sink DUT does not adequately support this video format, then
FAIL.

b. If this step fails for any video format listed in step 2, then FAIL.

HF2-7 Sink Video Timing - 6G - 2160p Deep Color

This test confirms that the Sink DUT supports deep color 2160p video formats
for TMDS Character rate 340 Mcsc upto 600 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer
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The following procedure is fully automated by Tektronix HDM Software

Measurement algorithm
Connect the equipment as shown in the Sink Protocol diagram for

1.
AWG7122C or Sink Protocol diagram for AWG70002A
Sink Protocol diagram for AWG7122C

AFG \ExiRefIn
AWGT122C (Slave)

=i
/L[, Ext Clock In I:

AWG7122C [ﬂ MHz Ref Out (Master)

Trig In A

J|Trig In A

¢ N —— e
Marker [CLK DO r—— \_______J Marker | D1 D2
output OFF o output
TN
YY DPO/DSA/MSO 70000 Series -
s Bias Bias
’ [ voltage voltage
Y D1
[
Power Eprly
A
-
O

Sink Protocol diagram for AWG70002A

AFG WE;I RefIn

AWG700024 | 10 MHz Ref Out (Master) = = o ® AWGT0002A (Slave)
e l [ Exl Clock In ol ,
i il o : E-X-

j\ 2
_ : = pesse |InginA Trig InA o
ol BHHH oeo o ol soBo
CLK DO | Marker D1 D2 Marker
output output
L
YYYY g DPO/DSA/MSO 70000 Series YV
T Bias T
{ I_ voltage volt@gg{ L
Y ot [ [oz ——
Power supply \
\. Do L
o ~7
= '-3,-: Second row of
; _ connectars below
\ ClK %
- o o

2. Select the required video format and color depth
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3. Perform the following tests for each of the video formats in the EDID:

a.

In the case of 24/30 Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.6% of 92.8125 MHz, 111.375 MHz
or 148.5 MH.

In the case of 25Hz formats, the TMDS clock frequency minimum and
maximum values are +0.5%/-0.5% of 92.8125 MHz, 111.375 MHz or
148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.
4. Then if DC_36bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max TMDS Character Rate of HF-VSDB in the EDID x 5 is
greater than 445.5 then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 36-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

5. Then if DC_30bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max TMDS Character Rate of HF-VSDB in the EDID x 5 is
greater than 371.25 then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 30-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
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DUT using 30-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

6. Then if DC_48bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max_TMDS_Character Rate of HF-VSDB in the EDID x 5 is
greater than 594 then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 48-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 48-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.
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HF2-8 Sink Video Timing - 6G - 2160p 3D

This test confirms that the Sink DUT supports 2160p 3D 2160p video formats for
TMDS Character rate above 340 Mcsc up to 600 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal generator: AWG70002A with options 01, 03 and 225 (quantity
2) OR AWG7122C with options 1, 2/6, 8 (quantity 2)

= AFG: AFG3102/AFG3102C/AFG3252/AFG3252C

m  Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test Fixture: HDMI 2-0 compatible Fixture
m  Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

= External power supply: PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

= Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
= DDC Master: Any approved DDC Master
= EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by Tektronix HDM Compliance
Software (Option HDM-DS):

1. CDF field Sink Above 340 is “N”, then Skip this test and go to the next test.

2. Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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3. Perform the following test for each of the video formats listed in the EDID:

a.

b.

In the case of 24/30/60Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.6% of 148.5 MH.

In the case of 25/50 Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.5% of 148.5 MHz.
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Check that the TMDS clock frequency accuracy is +/- 0.5%.

Output each of the video format timing listed in step 3, to a minimum
allowable TMDS clock frequency and maximum allowable TMDS clock
frequency. Perform steps 3 through 6 for each frequency.

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatcally the Vicml would be set to
2.6 V.

Recall the pattern on the AWG, then synchronize the master and slave
AWGS. Verify the Display is working, if not the result is FAIL.

If the Sink DUT does not adequately support this video format, then FAIL.
If this step fails for any video format listed in step 2, then FAIL.

HF2-23- Sink Pixel Decoding YCBCR 4:2:0

This test confirms that the Sink DUT supports YCBCR 4:2:0 Pixel decoding and
signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: one TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: 1- PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

If the CDF field Sink HDMI YCBCR 420 is “N”, then Skip this test and go
to the next test.

Connect the Sink DUT to any approved DDC master and EDID analyzer.

Turn on the Sink DUT, have the DDC Master output +5 V power and read
the sink DUT’s EDID in response to a hotplug.

If hotplug detect signal is not received or EDID is unreadable, then FAIL.
Connect the Sink DUT to the 297 MHz video generator.
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6. Make the connection as shown in the Sink Protocol diagram for AWG7122C

or Sink Protocol diagram for AWG70002A.

Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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7. Recall nominal pattern YCBCR 420 8 Bit Pattern with pixel clock frequency
297 MHz -0.5 % (or -0.6% when the frame rate is 60 Hz) with test image as
shown in following Figure, AVI Infoframe with Y2, Y1, YO=011 and
appropriate VIC, synchronize AWG’s.

If the Image /Video appear to be distorted or incorrect, then FAIL.

If color bars in the upper half of the active video are not in the order shown in
the Figure, then FAIL.

10. If black and white bars in the lower half of the active video are not evenly
spaced, then FAIL.

11. If black and white bars in the lower half of the active video contain a strong
blue or red tint when examined at close range, then FAIL.

12. Change Pixel clock frequency to 297 MHz +0.5%, synchronize AWG’s and
repeat steps 5 through 8.

13. If steps 5 through 8 pass then the test results are Pass; for all other conditions
it is Fail.
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HF2-24 Sink Pixel Decoding YCBCR 4:2:0 Deep Color

This test confirms that a YCBCR 4:2:0 Pixel encoding-capable Sink DUT
supports YCBCR 4:2:0 deep color pixel decoding and signaling.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

= HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

= AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

m  Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

m  Test fixture: HDMI 2-0 compatible fixture
m  Cables: one TF-HDM-TPA-S, one BNC T connector, three BNC cables

= External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

m  Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
= DDC Master: Any approved DDC Master
= EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Connect the equipment as shown in the connection diagram for Sink pixel
decoding — YCBCR 4:2:0. Recall the Nominal signal for the selected data
rate, synchronize the AWGS, and verify that the display is working fine; if
not, it will give result as fail. For nominal operation the connection diagram
should be same as shown in the Sink Protocol diagram for AWG7122C or
Sink Protocol diagram for AWG70002A.

128 TekExpress HDM Advanced Analysis and Compliance Solution



HDM - Sink Protocol tests

Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Output a YCBCR 4:2:0 Pixel encoded signal with a specified Pixel clock

frequency.
If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to

26 V.

3.
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Recall the pattern on the AWG, then synchronize AWGS. Verify that the
Display continues to work, if not the result is FAIL.

If the image/video appears to be distorted or incorrect, then FAIL.

If the color bars in the upper half of the active video are not in the order
described in appendix A, then FAIL.

If the black and white bars in the lower half of the active video are not evenly
spaced, then FAIL.

If the black and white bars in the lower half of the active video contain a
strong blue or red tint when examined at close range, then FAIL.

If all of the steps 4 through 8 pass, then the test passes, for all other
conditions, the test has failed.

HF2-25 Sink Video Timing - 21:9 (64:27)

This test confirms that a "21:9" (64:27)-capable Sink DUT, when it receives a
supported "21:9" (64:27) video format, it correctly decodes and displays it.

Required test Equipment

Measurement algorithm

130

In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: 1 AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: 1- PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits (ZX85-12G-S+)
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWGT7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG70002A

AFG WEXI Ref In

AWG70002A 10 MHz Ref Out (Master) o °® ¢ @ @ | AWGT0002A (Slave)
 EE— 5000 @ @ a
wic e [ Ext Clock In 2
, vose TighA TighhA | 6000
e BEHG oeoo J )@ so00
CLK DO | Marker D1 D2 Marker
output output
e
YYYY g DPO/DSA/MSO 70000 Series - y ‘3‘
{ { L voltage voltage L EL
111 Y D1 D2 —
Power supply
"
\_ CLK 4;_ ':3‘;;
S o -

2. Ifthe CDF field SINK Video Formats 21by?9 is all “N”, then Skip this test

and go the next test.
3. Read the EDID of the Sink DUT.
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For each of the VIC codes in the ranges 65..92 and 103..107, check the Short
video descriptors and the CDF field.

a. If support for this video format is listed in the EDID, but it is not
declared in the CDF field, then FAIL.

b. If support for this video format is not listed in the EDID, but it is
declared in the CDF field, then FAIL.

If aux power is used, give the popup to set the DC voltage. If Tektronix
power supply is used, then set the Vicm1 = 2.6 V, automatically.

Connect the Test signal generator to the Sink DUT.

For each of the VIC codes listed in CDF field SINK Video Formats 21by9,
configure the Test signal generator to generate the video timing specified by
the VIC code. The Test signal generator should have a Pixel clock frequency
accuracy of £0.05% or better. Also configure the Test signal generator to
output a test image that will allow the tester to observe if the Sink DUT
displays the image properly (for example., No distortions such as spurious
dots, jitter, wrong colors; correct aspect ratio and position).

a. If the Sink supports both VIC codes of a dual aspect ratio pair that share
a common video timing (see the rows in CEA-861-F Table 1 that have
two values in the “VIC” column), then test these VIC codes together by
doing the following:

a. Ifnecessary, put the Sink is in an automatic mode using CDF field.
Sink AutoZoomStretch procedure, where the user has not forced a
certain zoom or stretch.

b. Configure the Test signal generator to send the video timing
associated with the dual aspect ratio pair.

c. Configure the Test signal generator to output an AVI InfoFrame
containing the first VIC of the dual aspect ratio pair along with a test
image matching the aspect ratio of the VIC being sent in the AVI.
This allows the correct aspect ratio to be determined.

d. Observe the displayed aspect ratio #1. If the displayed picture is not
geometrically correct, then FAIL.

e. Reconfigure the Test signal generator to output an AVI InfoFrame
containing the other VIC of the dual aspect ratio pair along with a
test image matching the aspect ratio of the VIC being sent in the
AVI. This allows the correct aspect ratio to be determined.

f. Observe the displayed aspect ratio #2. If the displayed picture is not
geometrically correct, then FAIL.

b. For each unique video timing, test both the minimum and maximum
permitted Pixel clock frequencies as follows:

a. For video formats with a 25 Hz frame rate (or multiples thereof),
these values are the nominal rate -0.5% and the nominal rate +0.5%.

b. For video formats with a 24 or 30 Hz frame rate (or multiples
thereof), these values are the nominal rate -0.6% and the nominal rate
+0.5%.
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HF2-36 Sink Video Timing - 6G - Non-2160p 24 bit Color Depth

This test confirms that the Sink DUT supports 24-bit color depth non-2160p
video timings with a TMDS Character rate that is greater than 340 Mcsc
indicated in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture and
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

If the CDF field Sink_ Above 340 is “N”, then Skip this test and go to the
next test.

Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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Perform the following test for each of the video formats listed in the EDID:

a. In the case of 24/30/60 Hz formats (or multiples thereof), the TDMS
clock frequency the minimum and maximum values permitted are
+0.5%/-0.6%.

b. In the case of 25/50 Hz formats, the TDMS clock frequency minimum
and maximum values permitted are +0.5%/-0.5%.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

Output each of the non -2160p 24 bit color depth signal with minimum
allowable TMDS clock frequency and maximum allowable TMDS clock
frequency. Perform the steps 3 through 6 for each frequency.

If you use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
26V.

Recall the pattern on the AWG, synchronize the master and the slave AWGS.
Verify the Display is working, if not the result is FAIL.

If the Sink DUT does not adequately support this video format, then FAIL.
If this step fails for any video format listed in step 2 then FAIL.

HF2-37 Sink Video Timing - 6G - Non-2160p Deep Color

This test confirms that the Sink DUT supports deep color non-2160p video
formats for TMDS Character rate greater than 340 Mcsc indicated in the EDID.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal Generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: One AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time Filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test Fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer
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Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1. Ifthe CDF field Sink Above 340 is “N”, then Skip this test and go to the
next test.

2. Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.

Sink Protocol diagram for AWG7122C
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3. Select the required color depths supported by the sink DUT.
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4. Perform the following test for each of the video formats listed in the EDID:

a.

In the case of 24/30 Hz formats, the TMDS clock frequency minimum
and maximum values are +0.5%/-0.6% of 92.8125 MHz, 111.375 MHz
or 148.5 MHz.

In the case of 25 Hz formats, the TMDS clock frequency minimum and
maximum values are +0.5%/-0.5% of 92.8125 MHz, 111.375 MHz or
148.5 MHz.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

5. Then if DC_36bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max TMDS Character Rate of the HF-VSDB in the EDID x
5 is greater than or equal to 1.5 times the TMDS Character rate
corresponding to the video timing (when using 24 bit per Pixel) then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

a. a.IfDC Y444 of H14b-VSDB is equal to 1 in the EDID, then
configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 36-bit Pixel depth and YCBCR 4:4:4 Pixel
encoding at the minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

6. Then if DC_30bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max TMDS Character Rate of the HF-VSDB in the EDID x
5 is greater than or equal to 1.25 times the TMDS Character rate
corresponding to the video timing (when using 24 bit per Pixel) then:

a.

Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 30-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video Format, then
FAIL.
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If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 30-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

7. Then if DC_48bit of H14b-VSDB is equal to 1 in the EDID:

If the value of Max_TMDS_Character Rate of HF-VSDB in the EDID x 5 is
greater than or equal to 2 times the TMDS Character rate corresponding to
the video timing (when using 24 bit per Pixel) then:

a.
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Configure the TMDS Signal generator to transmit that video format to
the Sink DUT using 48-bit Pixel depth and RGB Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

If DC_Y444 of H14b-VSDB is equal to 1 in the EDID, then configure
the TMDS Signal generator to transmit that video format to the Sink
DUT using 48-bit Pixel depth and YCBCR 4:4:4 Pixel encoding at the
minimum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.

Configure the TMDS Signal generator to transmit the tested video format
to the Sink DUT at the maximum allowable TMDS clock frequency.

If the Sink DUT does not adequately support this video format, then
FAIL.
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HF2-38 Sink Video Timing - 6G - Non-2160p 3D

This test confirms that the Sink supports 3D and non-2160p video timings with a
TMDS Character rate that is greater than 340 Mcsc.

Required test equipment  In addition to the DUT and high-bandwidth digital oscilloscope, you will need
the following:

HDMI Signal generator: Two AWG70002A with options 01, 03 and 225 or
two AWG7122C with options 1, 2/6, 8

AFG: 1 AFG3102/AFG3102C/AFG3252/AFG3252C

Rise time filter: Two 120 ps TTC filter from Pico Second Pulse Labs
(5915-100-1200)

Test fixture: HDMI 2-0 compatible fixture
Cables: One TF-HDM-TPA-S, one BNC T connector, three BNC cables

External power supply: One PWS4721 / PWS4602 / PWS4323 / PWS4305 /
PWS4205

Bias Tees: Eight Bias Tees from Mini-Circuits — ZX85-12G-S+
DDC Master: Any approved DDC Master
EDID Analyzer: Any approved EDID analyzer

Measurement algorithm  The following procedure is fully automated by TekExpress HDM Software:

1.

Connect the equipment as shown in the Sink Protocol diagram for
AWG7122C or Sink Protocol diagram for AWG70002A.
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Sink Protocol diagram for AWG7122C
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Sink Protocol diagram for AWG70002A
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2. Perform the following test for each of the video formats listed in the EDID:

a. In the case of 24/30/60 Hz formats (or multiples thereof), the TDMS
clock frequency minimum and maximum values permitted are
+0.5%/-0.6%.

b. In the case of 25/50 Hz formats, the TDMS clock frequency minimum
and maximum values permitted are +0.5%/-0.5%.

Check that the TMDS clock frequency accuracy is +/- 0.5%.

3. Output non -2160p 3D signal with minimum allowable TMDS clock
frequency and maximum allowable TMDS clock frequency and perform
steps 4 through 6 for each frequency.

4. Ifyou use an auxiliary power supply, set the DC voltage in the pop-up field.
If you use a Tektronix power supply, automatically the Vicml would be set to
2.6 V.

5. Recall the pattern on the AWG, synchronize the master and slave AWGS.
Verify the Display is working, if not the result is FAIL.

If the Sink DUT does not adequately support this video format, then FAIL.
7. [If this step fails for any video format listed in step 2, then FAIL.
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Map the My TekExpress folder

Map the shared My TekExpress folder as X: (X drive) on all instruments used
in test setup running Microsoft Windows Operating System. The My
TekExpress folder has the shared name format <domain><user ID>My
TekExpress. Or, if the instrument is not connected to a domain, then the share
name format is <instrument name><user ID> My TekExpress. This
shared folder is used to save the waveform files and is used during any other file
transfer operations.

To map the My TekExpress folder on the instruments, follow these steps:
1. Open Windows Explorer.

2. From the Windows Explorer menu, click Computer.

3. In the menu bar, click Map network drive.
4

Select the Drive letter as X: (if there is any previous connection on X:,
disconnect it first through Tools > Disconnect Network drive menu of
Windows Explorer. Windows 7 users: if you do not see the Tools menu,
press the Alt key).

5. In the Folder field, enter the remote My TekExpress folder path (for example,
\\192.158.97.65\My TekExpress)

6. Click Finish.

To determine the IP address of the instrument where the My TekExpress folder
exists, do the following:

1. On the instrument where the My TekExpress folder exists, click Start and
select Run.

2. Type “cmd” and then press Enter.
3. At the command prompt, type “ipconfig” and then press Enter.
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Acquire Status, 37
Acquisitions tab, 34
Activating the license, 21
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Connection requirements
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Probe setup illustration
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R
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S
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